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S3C2440A ABOUT SMDK?2440 BOARD

ABOUT SMDK?2440 BOARD

SMDK?2440 CPU and Base board revision number.

CPU Board Version Rev 0.19

Base Board Version Rev 0.19

SYSTEM OVERVIEW

SMDK?2440 (S3C2440 Development Kit) for S3C2440A is a platform that is suitable for code development of
SAMSUNG's S3C2440A 16/32-bit RISC microcontroller (ARM920T) for hand-held devices and general
applications.

The S3C2440A consists of 16-/32-bit RISC (ARM920T) CPU core, separate 16KB instruction and 16KB data
cache, MMU to handle virtual memory management, LCD controller (STN & TFT), NAND flash boot loader,
System Manager (chip select logic and SDRAM controller), 3-ch UART, 4-ch DMA, 4-ch Timers with PWM, I/O
ports, RTC, 8-ch 10-bit ADC and touch screen interface, IIC-BUS interface, 11S-BUS interface, AC97 interface,
USB host, USB device, SD host & multimedia card interface, Camera Interface, 2-ch SPI and PLL for clock
generation.

The SMDK?2440 consists of S3C2440A, boot EEPROM (Flash ROM), SDRAM, LCD interface, two serial
communication ports, configuration switches, JTAG interface and status LEDSs.

SMDK?2440 OVERVIEW

The SMDK?2440 (S3C2440 Development Kit) shows the basic system-based hardware design which uses the
S3C2440A. It can evaluate the basic operations of the S3C2440A and develop codes for it as well.

SMDK?2440 is manufactured by MERITECH Co., Ltd and its website is www.mcukorea.com

When the S3C2440A is contained in the SMDK2440, you can use an in-circuit emulator (MULTI-
ICE/REALVIEW-ICE (RVI)/OPENice32-A900).

This allows you to test and debug a system design at the processor level. In addition, the S3C2440A with
MULTI-ICE/ REALVIEW-ICE (RVI)/OPENice32-A900 capability can be debugged directly using the MULTI-ICE/
REALVIEW-ICE (RVI)/OPENice32-A900 interface.

Figure 1-1 shows SMDK2440 function blocks.
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Figure 1-1. SMDK2440 Function Block Diagram
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FEATURES

— S3C2440A: 16/32-bit RISC microcontroller
— X-tal operation or oscillator

— Boot ROM: AMD 8M bit 1EA (support half-word size boot ROM)
Intel StrataFlash 16M-Byte x 2 ( word: 16M-Byte x 2 EA): Unload (Option)

SAMSUNG NAND flash 64M-Byte 1EA (smart media card),
SAMSUNG NAND flash 64M-Byte 1EA (sop type)

— SDRAM: 64M-Byte (32M-Byte x 2)

— SRAM: 256K x 16 — Unload(Option)

— TFT/STN LCD and touch panel interface

— Three-channel UART (including IrDA)

— One Host Type USB port & Selectable Device and Host Type USB port

— SD host (MMC) interface

— Smart media card

— JTAG port (MULTI-ICE/REALVIEW-ICE(RVI)/OPENice32-A900 interface)

— RTC X-tal input logic

— IIC with KS24C080

— ADC interface

— SPl interface

— lIS interface (sound CODEC audio input/output)

— AC97 interface (sound CODEC audio input/output)

— EINT interface

— GPIO Switch Interface

— IrDA interface

— Ethernet interface

— PCMCIA interface

— Extension connector 34P * 3 EA

— LED display (debugging)

— CAMERA Interface
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S3C2440A

CIRCUIT DESCRIPTION

The SMDK2440 is designed to test S3C2440A and develop software while hardware is being developed. Figure

1-3 shows SMDK?2440's block diagram.

POWER SUPPLY

SMDK2440 is operated by 1.2V for ARM core, 1.0V for VDDalive, 1,8V for Extension 1/O, 2.5V/3.3V for Memory

and 3.3V for I/O pad and several peripherals. SMDK2440 is supplied by 9V/2A DC Adaptor Power.

The SMDK2440 has distributed power plane, with power going separately to the MCU and the main power
plane. For this reason, power jumpers including J4-C~J13-C, J15-C on the CPU board, J11-B and J601-B on

the base board are inserted.
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Figure 1-2. SMDK2440 Power Plane
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S3C2440A
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SMDK?2440 SYSTEM CONFIGURATIONS

CLOCK SOURCE

EXTCLK or X-TAL can be selected for the system clock of S3C2440A and USB by the suitable setting of OM
values.

Table 1-1. System Clock (MPLL) & USB Clock (UPLL)

PIN FUNCTIONS OM[3:2] DESCRIPTIONS

Clock source selection MPLL: XTAL, UPLL: XTAL

MPLL: XTAL UPLL: EXTCLK

MPLL: EXTCLK, UPLL: XTAL

Pk, |]O|O
R |O|Fr,|O

MPLL: EXTCLK, UPLL: EXTCLK

RTC Clock
32.768KHz, X-tal is available in SMDK2440 as the RTC clock source.

NOTES:

1. Although the MPLL starts just after a reset, the MPLL output (Mpll) is not used as the system clock until the software
writes valid settings to the MPLLCON register. Before this valid setting, the clock from external crystal or EXTCLK
source will be used as the system clock directly. Even if the user wants to maintain the default value of the MPLLCON
register, the user should write the same value into the MPLLCON register.

2. OM[3:2] is used to determine test mode when OM[1:0] is 11.

RESET LOGIC

The nRESET (system reset signal) must be held to low level at least 4 CLKSs to recognize the reset signal and it
takes 128 CLKs between the nRESET and internal NRESET. nRESET and nTRST (JTAG reset signal) are
connected through jumper J3-C on the CPU board.

CUET
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BOOT ROM (BANKDO)
The data bus width of BANKO can be configured in byte, half-word or word in S3C2440A.

In the case of SMDK2440, half-word data bus width (AMD flash memory), half-word or word data bus width
(STRATA flash memory), and byte or half-word data bus width (Samsung NAND flash memory) access can be
selected by the suitable jumper setting.

AMD flash or STRATA flash memory can be selected by using jumper (J3-B & J4-B) option for boot ROM.
In the SMDK?2440, the data bus width of AMD flash memory is fixed by half-word data width (16-bit) and
STRATA flash memory can use word (32-bit).

But AMD flash and STRATA flash cannot be selected for BANKO or BANK1 at the same time.
Data bus width of BANKO should be set by memory type of BANKO. It is set by OM[1:0](J2-B & J1-B).

nGCSO nGCSO

E J3-B 1 a J4-B

1
2 E 2 E

NCE_S32 nCE_A16
3 3

nGCS1 nGCS4

BankO - AMD Flash 16bit

nGCSO0 nGCS0

1 E J3-B 1 |o| Ja-B
2 E 2o
nCE_S32 nCE_A16
3 E 3|0
nGCs1 nGCS4

BankO - Intel Strata Flash 32bit

SOP_nFCE

SOP_nFCE
1 E J9-B 1 E Jo-B
28
NFCE 2 a
3 E 3 a
SMC_nFCE SMC_nFCE
BankO -NAND Flash SOP Type BankO -NAND Flash SMC Type

Figure 1-4. SMDK2440 Board Memory Configurations
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Table 1-2. Memory Type and Data Bus Width

J3-B J4-B
Pin Functions Descriptions
1-2 2-3 1-2 2-3

Open Short | Short | Open | AMD flash memory : BANKO
STRATA flash memory : BANK1
Data bus width of BANKO : Half-word

Data bus width of BANK1 : Word
BANKO/1/4 memory type

selection and data bus width
configuration Short | Open | Open Short | AMD flash memory : BANK4

STRATA flash memory : BANKO
Data bus width of BANKO : Word
Data bus width of BANK4 : Half-word

Table 1-3. Boot Memory Type and Bus width configuration OM[1:0]

Pin Functions J1-B [OMO] J2-B[OM1] Descriptions
2-3(L) 2-3(L) NAND Boot
Boot memory type and 2-3(L) 1-2(H) Word (32-bit)
bus width configuration 1-2(H) 2-3(L) Half Word (16-bit)
1-2(H) 1-2(H) Test Mode

NAND FLASH CONFIGURATION

Table 1-4. NAND Flash Type Selection

OM[1:0] = NAND Boot Setting (L, L)
J5-B(NCON 0) 2-3(L) 1-2(H)
Normal NAND Advanced NAND
J6-B( PAGE) 2-3(L) 256 1024
1-2(H) 512 2048
J7-B( ADDR) 2-3(L) 3 Cycle 4 Cycle
1-2(H) 4 Cycle 5 Cycle
J8-B (WIDTH) 2-3(L) 8-bit Bus Width
1-2(H) 16-bit Bus Width
J9-B ( NAND Select) 2-3(L) Use SMC NAND
1-2(H) Use SOP NAND

NOTE:
- Jumpers on the base board: J1-B, J2-B, J3-B, ...

CUET
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GENERAL I/0O PORTS

The S3C2440A's general I/O ports are used for SMDK2440 key interrupt input, normal input and LED status
display. The function of control switch and the status of LED can be defined by user software.

Table 1-5. General 1/0O Configurations on SMDK2440

General I/O Port Number I/0 Type Descriptions
GPF[7:4] Output LED display
GPFO, GPF2, GPG3 & GPG11 Input Key input pad (external interrupt input pins).

(EINTO, 2, 11 & 19)

U4 (EPM7032) XDMA CHANNEL SELECTION

Table 1-6. U4-C XDMA Channel Selection

Pin Functions J1-C J2-C Descriptions
XDMA channel selection (1-2) (1-2) NXDREQO, nXDACKO
(2-3) (2-3) nXDREQ1, nXDACK1

NOTE:

- Jumpers on the CPU board: J1-C, J2-C, J3-C, ...
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LCD INTERFACE

TFT/STN LCD controllers are equipped in the S3C2440A. TFT/STN LCD, touch panel and LCD backlight driver
are supported in the SMDK2440.

NOTES:
It is supported 2-type SEC TFT LCD panel(SAMSUNG 3.5” Portrait/256 Color/Reflective a TFT LCD)

LTS350Q1-PD1 Panel with touch panel and front light unit
LTS350Q1-PD2 Panel only
LTS350Q1-PE1 Panel with touch panel and front light unit
LTS350Q1-PE2 Panel only

TOUCH SCREEN

CONG6

TSYP
TSYM
TSXM
TSXP

YyVvYyYyYY

A W N P

Figure 1-5. Touch Panel Film Connector on SMDK2440

CUET
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SPI Connector

Figure 1-6 shows the way SMDK?2440 provides SPI (CON15) signals.

CON15

«

<

g N W N P

¢—— P SPICLK
4— > SPIMOSI

» SPIMISO
p nSS_SPI

Figure 1-6. SPI Connector on SMDK2440

A/D CONVERTER INTERFACE

The S3C2440A has Analog to Digital Converter (ADC). The ADC has 8-ch analog input signals.

The SMDK2440 provides the ADC (CONB) signals as follows:

Table 1-7. ADC Interface on SMDK?2440

# of pin | Descriptions | # of pin Descriptions | #of pin | Descriptions | # of pin Descriptions
1 AINO 4 AIN3 7 TSXM 10 GND
2 AIN1 5 TSYM 8 TSXP
3 AIN2 6 TSYP 9 EINT20
ELECTRONICS
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SD HOST (MMC) INTERFACE
SD(MMC) is provided by the S3C2440A and SD card socket (CON13) is supported in the SMDK2440

VDD3.3V

11 nCD_SD

10 WP_SD
SDDATA1L
SDDATAO

SDCLK

SDCMD
SDDATA3
SDDATA2

© P N Whh 00O N @®

GND jp—

Figure 1-7. SD Card Socket on SMDK?2440

[IC INTERFACE

Serial EEPROM S524C80D80 (KS24C080) access function is provided by SMDK2440 and there is also 1IC
interface between S3C2440A and camera module through U37-B (CBTD3306) buffer.

CUET
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USB INTERFACE

Dual USB Connector(CON3) for Two USB port A-Type and one USB port B-type(CON5) are supported by the
SMDK2440.

CONB3A T VDD5V CON3B T VDD5V CONS5
1 VBUS 1 VBUS 1 [—Resister VBUS
2 l«———p» DNO(D-) 2 [¢&———» DNI(D-) 2 [«———» DNI(D-)
3 |«———» DPO(D+) 3 |«———» DP1(D+) 3 |«—» DP1(D+)
a a a
GND GND GND

USB port A-type USB port A-type USB port B-type
(USB Host) (USB Host) (USB Device)

Figure 1-8. USB Ports on SMDK2440

You can be select the USB port 1 (DN1, DP1) by Jumper (J14-C, J16-C)

B-Type CON B-Type CON
1 a Ji4a-c 1 a Jie6-C
2 E DN 2 E DP1
3 E 3 E
A-Type CON A-Type CON
USB Portl A-Type Connection(USB Host)
B-Type CON B-Type CON
1 E J14-C 1 a J16-C
> E DN1 2 E DP1
3 E 3 H
A-Type CON A-Type CON
USB Portl B-Type Connection(USB Device)
Figure 1-9. USB Portl Selection
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S3C2440A

UART interface

The S3C2440A UART unit provides three independent asynchronous serial I/O (SI0O) ports including IrDA.
In SMDK2440 board, a user can change the ports connected to connectors by setting related jumpers.

Table 1-8. UART Configurations

Pin Functions J16-B, J18-B J17-B, J19-B Descriptions
UART configurations (2-3) (1-2) CON14: UARTO,
CON22: UART1
(1-2) (2-3) CON14: UARTO,
CON22: UART2

CON14 (Female) CONZ22 (Female)

/_\O—l— nDCD /_\O—%(
O——16  nDTR o—+2x
O—2— Txpo O—2—TXD1(TXD2)
O———ncTso O——5—ncTs1
O—3— rXDO O—B—RXDl(RXDZ)
O——+8— nRrTs0 O— 4, NRTS1
O—4— nDsSR O—g—X
O—%( O———x
MO GND M: GND

Figure 1-10. UART Ports on SMDK2440
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IrDA INTERFACE

IrDA is supported by SMDK2440 and J17-B and J19-B should be set to UART2 (RXD2 and TXD2) for IrDA.

IrRXD IF'TXD
RXD2 TXD2
Figure 1-11. SMDK?2440 Board IrDA Configurations
Table 1-9. IrDA Configurations
Pin Functions J17-B, J19-B Descriptions
UART2 (2-3) Set UART mode
IrDA (1-2) Set IrDA mode

ST
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EXTENSION CONNECTOR INTERFACE

Table 1-10. Extension Connector (CON10, CON11 & CON12) on SMDK?2440

# of pin | Descriptions |# of pin Descriptions | # of pin | Descriptions | # of pin | Descriptions

1 GND 10 DATAS 19 DATA17 28 DATA26
2 DATAO 11 DATA9 20 DATA18 29 DATA27
3 DATA1l 12 DATAL0 21 DATA19 30 DATA28
4 DATA2 13 DATAl1 22 DATA20 31 DATA29
5 DATA3 14 DATA12 23 DATA21 32 DATA30
6 DATA4 15 DATA13 24 DATA22 33 DATA31
7 DATAS 16 DATA14 25 DATA23 34 -

8 DATAG6 17 DATA15 26 DATA24 - -

9 DATAY 18 DATAL6 27 DATA25 - -

# of pin | Descriptions | # of pin Descriptions | # of pin | Descriptions | # of pin | Descriptions

1 GND 10 A8 19 Al7 28 nWBEO
2 A0 11 A9 20 Al8 29 nWBE1
3 Al 12 Al10 21 Al19 30 nWBE?2
4 A2 13 All 22 A20 31 nWBE3
5 A3 14 Al2 23 A21 32 nWE
6 Ad 15 Al13 24 A22 33 nOE
7 A5 16 Al4 25 A23 34 -
8 A6 17 Al5 26 A24 - -
9 A7 18 Al6 27 nWAIT - -
# of pin | Descriptions | # of pin Descriptions | # of pin | Descriptions | # of pin | Descriptions
1 nGCS2 10 GPG7 19 nXDACK1 28 GND
2 nGCS1 11 GPG2 20 nXDREQO 29 GND
3 nGCS4 12 GPG8 21 GPG5 30 NRESET
4 nGCS3 13 GPG3 22 nXDREQ1 31 VDD5V
5 nGCS7 14 GPG9 23 VDD1.8V 32 VDD3.3V
6 nGCS5 15 GPG4 24 GPG12 33 CLKOUT1
7 GPGO 16 GPG10 25 GND 34 GND
8 GPG6 17 nXDACKO 26 CLKOUTO - -
9 GPG1 18 GPG11 27 VDD3.3V - -
1-16 wﬂjcmowlcs
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CAMERA INTERFACE CONNECTOR

Figure 1-12 shows the connector pin assignment for camera interface on SMDK2440

o
VDD2.8V QO vDD5V
CON19
2 1
= 4 3
6 5
? s 7 OVDD2.8V
*——
x—o— X
XCAM_Y1 12 11 XCAM_YO
XCAM_Y3 14 13 XCAM_Y?2
XCAM_Y5 16 15 XCAM_Y4
XCAM_Y7 18 17 XCAM_Y6
XPCLK 20 19 XCAMCLK
XVSYNC 22 21
24 23 XHSYNC
————
XIICSCL 26 25 XIICSDA
28 27
*—
NnXDACKO, 30 29 NXCAMRST
32 31 XCAMRST
34 33
36 35
38 37
40 39
_ = GND = =

Figure 1-12. CAMERA Interface Connector on SMDK?2440
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IS & AC97 INTERFACE

SMDK?2440 supports the 1IS & AC97 interface. Because AC97 controller and the IIS controller must not be
used at the same time, Only one interface of them should be selected by using following resistor configuration.

Table 1-11. IS or AC97 Interface Selection on SMDK2440

AC97 s
RN1, RN3, R280 SHORT OPEN
RN2, RN4, R281 OPEN SHORT
HEAD PHONE
v U
AN
RN1 1%7 2] 3
AC97 LO 1 8
AC97 RO 2 7
AC97 Ml 3 6
4 5
F/\/\/\%(
0 (Unload) MIC
2
RN2 1
s_LO 1 8
IIS_RO 2 7
ns_mi 3 6
>L /\/\/\%5
0
R280
X97RESETn 0 (Unload) CDCLK
RN3
X97SDI 1 8 12SSDI
X97SDO 2 7 12SSDO
X97BITCLK 3 6 12SSCLK
X97SYNC 4 S I2SLRCK
0 (Unload)
R281 0
X2sCDCLK AN\
RN4
X2sDI 1 8
X2sDO 2 7
X2sCLK 3 6
X2sLRCK 4 5
0
Figure 1-13. IS or AC97 Configurations
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NOTES

ST
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TOOLKIT AND DEBUGGING

SMDK2440 ENVIRONMENT SETUP

The evaluation environments for the SMDK2440 are shown in Figure 2-1. The serial port (UARTL1) on the
SMDK2440 has to be connected to COM port of the host PC. This can be used as a console for monitoring and
debugging the SMDK2440. And the USB device on the SMDK2440 should be connected to the USB host of the
host PC for downloading test images.

If you have an emulator such as MULTI-ICE, RealView ICE(RVI) and OPENice32-A900, you can use JTAG port
on the SMDK2440 to interface the emulator.

IHostPC

COM?2
LPT1 == [—— 7=
RS232 cable
UusB L 1
USB host
ETH Adapter DC9V
USB cable
MULTI-ICE/
REALVIEW ICE/
OPENice32-A900
| USB host || USB device || UART1 Regulator

5V

JTAG 3.3V

S3C2440A

Regulator
Regulators

SMDK2440

Figure 2-1. Setup Environment for SMDK2440 Board
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RS232C CABLE CONNECTION

The serial cable is made as in Figure 2-2. The pins numbered only 2, 3, and 5 are used; make sure to check the
cable's connections to prevent other pins from being used.

The UART1(CON22) and PC COM1 or COM2 port has to be connected through this cable connection.

For Host For SMDK2440
(Female D-SUB9) (Male D-SUB9)
5 5
O ™~ A O
O @)

O 3 3 @)
O O

O @)

M 212 o
@) @)

Figure 2-2. Serial Cable Connections for SMDK2440 Board
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USB DOWNLOADER INSTALLATION (ON WINDOWS 98, ME, 2000 OR NT)

To install the USB downloader, follow the steps:

. Program the u2440mon.bin into the flash memory of SMDK2440X board.
. Configure Boot Jumper Setting (J1-B ~ J9-B).

. Turn on the SMDK?2440.

. If you installed the device driver for SMDK2400X/SMDK2440X before, overwrite new ‘secbulk.sys’ at
C:\WINDOWS\SYSTEM32\DRIVERS. In this case, the step 6 will be skipped.

5. Connect the SMDK2440X board with the PC (See Figure 2-3).

6. When the USB device driver installation window appears, install the USB device driver (secbulk.inf).
Note: ‘secbulk.inf and ‘secbulk.sys’ should be in the same directory (See Figure 2-4).

A W N P

7. Run ‘dnw.exe’.
8. Turn the SMDK2440 off and then on.
9. The message ([USB:OK]) in the window title bar indicates that the installation is successfully completed.

Add Hew Hardware Wizard

Thiz vizard zearches for new drivers for:

SEC S3C24400< Test BAD

& device driver iz a sofbware program that makes a
hardweare dewice work,

<Back i Newt> | Cancel |

Figure 2-3. Add New Hardware Wizard (Window98)

NOTES:
1. If you have installed the device driver before, replace the old 'secbulk.sys' in CAWINDOWS\SYSTEM32\DRIVERS with

the new 'secbulk.sys'.
The maximum speed of the 'secbulk.sys' with SMDK2440 will be about 980KB/S.

'‘dnw.exe"; PC USB/serial downloader program.
'secbulk.inf' and 'secbulk.sys': PC USB driver.
'u2440mon.bin": S3C2440A USB downloader firmware.

abhwbd
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Add Hew Hardware Whzard

Windows will zearch tor new divers in itz diver databaze
on wour hard drive, and in any of the following selected
locations. Chck Hext to start the search.

[ Floppy disk drives
[~ CD-ROM drive
W Microcoft Windows U pdate

M Specify a location:
IE:ch‘rk\.EMDRUS Bdowrloader :I

< Back | Meut > | Cancel !

Add Mew Hardware Wizard

Windows diiver file zeanch for the device:

SEC SOC Te:t Board

Windows iz now ready to install the best diver for this
device. Chck Back ba zelect a different diver. or chick Nest
to continue.

Location of driver:

= CAWOR K440 5BD W INSECBULEINF

< Back

Cancel ‘

Figure 2-4. USB Device Driver Installation
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Add New Hardware Wizard

% SEC S0C Test Board

Windows hasz finizhed installing the zoftware that pour new
hardware device reguines.

& Hack Firigh

Figure 2-4. USB Device Driver Installation (Continued)

CONFIGURING DNW
To configure the DNW, which works as USB and serial download utility, follow the steps:
Run the DNW.

Select Options from the Configuration menu (See Figure 2-5).
Configuration - Options

3. Select Baud rate for serial communication.
Serial communication properties of the DNW are as follows:
Data bits:8-bit / Stop bits:1 / No flow control

Select a COM port of the host PC to communicate with the SMDK2440.
Set USB download address.
Click the OK button.
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E

[COMI,1152000ps]fusBiokl [ [§]x]

UART/USB Options

r Serial Port- o
—Baud Rate | — COM Port

« 115200 * COM1 Cancel
7600 © COM 2 =
" 38400 " COM 3

19200 " COM 4

14400

-

9600

~USB Port-
Download Address [0x30000000

Figure 2-5. Setting UART/USB Options
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CONNECT HOST PC AND SMDK2440 WITH DNW

After setting UART/USB options, users can activate UART and USB communication.

1. Select Connect from the Serial Port menu.
Serial Port > Connect

2. Power on the SMDK2440 (See Figure 2-6).

ol DNWY v0.504 [COM1,115200bps] [USB: OK]
Serial Port USB Port Configuration  Help

CEX

DIUM UPLLA
MPLLUal [M:58h,P:1h,5:1h]
CLEDIUN:Zh

FCLEK=192MHz ,DHA mode
USB: IM_EHMDPOINT 1 OUT_EMDPOINT:2
FORMAT = <ADDR{DATA) :4>+<{SIZE(n+18) :4>+{DATA:N>+{C5:2>
HOTE: 1. Power off/fon or press the reset button for 1 sec
in order to get a valid USB device address.
2. For additional menu, Press any key.

USB host is connected. Waiting a download.

Figure 2-6. Power On Screen
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INSTALL ARM TOOLKIT
First of all, install ARM toolkit 2.51, ADS (ARM Developer Suite) 1.0.1 or ADS1.1.

If you installed ARM toolkit 2.11a, then Makefile has to be changed a little. The toolkit 2.11a cannot support
fromelf.exe utility. We recommend ARM Developer Suite 1.0.1, which is used in our development environment.
We also recommend ADS 1.1.

The DOS environment variable has to be changed as follows after the installation of ARM toolkit 2.51.

SET ARMLIB=C:\ARM251\LIB\embedded
SET ARMINC=C:\ARM251\INCLUDE

HOW TO BUILD EXECUTABLE IMAGE FILE

Executable image file can be built by using the ARM Project manager or makefile. First, you have to build ELF
format image (*.ELF or *.AXF). An ELF format image can be used for the ARM debugger directly. The binary file
(.bin file) can be extracted from ELF format image.

First of all, you have to download S3C2440A evaluation source code and any other utilities from our web site
(www.samsungsemi.com). They are helpful for you to understand the development environments of S3C2440A in
an easier way. The distributed evaluation source code consists of following directories.

Directory Description
BMP Graphic header file converted from BMP file

obj Obiject files

err Error files

BUILDING 2440TEST.AXF (OR 2440TEST.ELF)
To build the sample source code, 2440TEST, run Makefile using the following commands.

cd 2440Test
armmake —a

or

cd 2440Test
make clean
make

After the procedure, 2440TEST.AXF (or 2440TEST.ELF) and 2440TEST.BIN image files will be seen in
2440TEST directory. The 2440TEST.AXF (or 2440TEST.ELF) file is used for ARM debugger.

The 2440TEST.BIN file is used for downloading through USB.
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EXECUTING 2440TEST WITHOUT ARM MULTI-ICE OR OPENICE32-A900

First, U2440MON has to operate on ROM. U2440MON will be ready to receive 2440TEST.BIN. U2440MON will
launch 2440TEST.BIN after receiving 2440TEST.BIN.

To download 2440TEST.BIN through USB, after connecting the host PC and the SMDK2440 with the DNW follow
the steps below:

1. Select Transmit from the USB Port menu.
USB Port 2 Transmit

2. Select 2440TEST.BIN (See Figure 2-7).
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-/ DNW v0,504 [COM1,115200bps] [USB: OK] L EX]
Serial Port USB Port Configuration  Help

FCLE=192MHz ,DMA mode
USB: IHN EHDPOINT:1 OUT_EHDPOIHNT:=3
FORMAT : <ADDR{DATA) :4>+<SIZ2E{n+18) :4>+<{DATA:n>+<CE:2>
HOTE: 1. Power offfon ov press the reset button for 1 sec
in order to get a valid USB device address.
2. For additional menu, Press any key.

USB host is not connected yet.
USB host is connected. Waiting a download.

How, Downloading [ADDRESS:30000000L,TOTAL :3908118]
RECEIUVED FILE SIZE: 398118(1816.1KB/5,8.45)

How, Checksum calculation

Download 0.K.

[SHDE2448 Board Test Program Uer B8.8]

[Fclk:Hclk:Pclk]=[283.2:101.6:50.8]Hhz
[Uclk=48.8Mhz]

B:User Test 1:Manual Reg Set 2:PCHCIA test 3:Stepping stone
L:npWAIT test L:Hand test 6:Program Flash 7:DMA test

8:FIQ test 9:EINT test 18:Cpu speed test 11:Power/Clk test
12:Lcd test 13:Camera test 14:5PI Test 15:1IC Test
16:RTC Test 17:1IvDA Test 18:3D test 19:ADC test
20:ADC TS test 21:Timer test

Select the function to test :

Figure 2-7. 2440TEST Execution After its Downloading through USB
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HOW TO USE ARM DEBUGGER WITH ARM MULTI-ICE

If you have built 2440TEST program without any error, you can find 2440TEST.AXF in 2440TEST directory. The
generated image file will be downloaded to SDRAM memory on the SMDK2440 by ARM debugger through MDS
like a MULTI-ICE. Next, you can start to debug the downloaded image using the ADW (ARM Debugger for
Windows).

If you didn't apply the patch for Multi-ICE v2.2, you must follow the below procedure. But, if you were applied the
patch for Multi-ICE v2.2 which can download at http://www.arm.com without payment, you can very easily to use
the MULTI-ICE. Because, you can setup the MULTI-ICE server program by “Auto-Configure” menu.

PREPARING AND CONFIGURING ARM MULTI-ICE
1. MULTI-ICE will be connected through JTAG port on the board. Connect all cables properly following its
manual.
Start the ARM MULTI-ICE Server (Double click the MULTI-ICE Server icon).
Select Load Configuration from File menu and load 2440.CFG (See Figure 2-8).
File = Load Configuration
4. Contents of 2440.CFG are as follows:

[TITLE]
S3C2440/S3C2440 TAP Configuration

[TAP 0]
ARM920T

[Timing]

Adaptive=OFF
5. Select Start-up Options from Settings menu.

Settings - Start-up Options
6. Start-up Options dialog box is displayed (See Figure 2-9).

Now you can select Load Configuration from Start-up Configuration and browse 2440.CFG
7. Start ARM Debugger using ARM debugger icon

Also, you can start the debugger at DOS command window by typing adw 2440TEST.AXF.
If you use ARM MULTI-ICE for the first time, you have to add Multi-ICE.DLL to ADW.

8. When ARM Debugger is started, it will load the image code to the Armulator (The Armulator is software
emulator for ARM920T CPU).

ELECTRONICS 2-11

Preliminary product information describes products that are in development,
for which full characterization data and associated errata are not yet available
Specifications and information herein are subject to change without notice.



2004.03.27

TOOLKIT AND DEBUGGING

S3C2440A

% ARQM — Multi-ICE Server
Eile Miew Hun Control Connection settings Help

Load Configuration, ., Cirl+L
Auto-Configure Ctrl+A
Auto-Configure at 20kHz muration

Reset Target Ctrl+R

Log
Set Log File,,

12440, cfg

Exit
-

ILual:Is a configuration file Inputbits [l 1 BN 2 -

Figure 2-8. Load Configuration

Start-up Options

Metwiork SEﬁII‘IQS

v iollow Metwork Connections

v Start Portrap Service ﬂ
Help

Star-up Configuration
" Mone
 Auto-Configure
" Auto-Configure at 20kHz
¢ Load Configuration
Loaded File

|Catulti-ICEW 2440, cfg

Browse, .,

Figure 2-9. Start-up Configuration
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CONFIGURING ARM DEBUGGER FOR ARM MULTI-ICE

In order to access a remote target, you should configure ARM Debugger for Windows (ADW) or ARM Extended
Debugger(AxD). There are two kinds of ADW: one for Software Development Toolkit (SDT) and the other for ARM
Developer Suit (ADS). These two kinds of ADW are basically same except some trivial differences. The below
explanation will be described with AXD of ARM Developer Suit (ADS).

The MULTI-ICE interface unit must also be configured for the ARM core in the target system. The ARM920T core
is contained in the S3C2440A on the SMDK2440 board.

To configure AXD Debugger using the MULTI-ICE interface, follow the steps:

1. Select Configure Debugger from the Options menu.
Options -> Configure Target

2. Debugger Configuration dialog box is displayed (See Figure 2-10).
If there is no Multi-ICE in the target environment, then you have to select Add button and Multi-ICE.DLL.
— ARMulator: lets you execute the ARM program without any physical ARM hardware by simulating ARM
instructions in software.
— Multi-ICE: connects the AXD Debugger directly to the target board or to a MULTI-ICE unit attached to the
target.

Select Multi-ICE from Target environment, and click the Configure button.

Configure ARM Multi-ICE dialog box (See Figure 2-11).
— Connect page: select your host and MULTI-ICE communication target configuration.
— Processor Settings page: set the cache clean code address.

5. Select Advanced from Debugger Configuration dialog box (See Figure 2-12) and configure it.
— Endian: little (If the big endian is used, Endian: big has to be selected.)

6. If you click the OK button on Debugger Configuration dialog box, the debugger will be restarted. The restarting
dialog box is displayed and numbers are rapidly changing, indicating that it is reading and writing to the target.
This means that the executable image file is downloaded to the SDRAM code area.

This configuration is initially done and the setting is saved, which relieves the user of repeating another
configuration next time.
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Target Environrments

reion | Add
0, 337 Hernowe |
Rename |

Save Az |

L EEIinwRemote _a, dlf
";"';"Eimw.ﬁ.HMuIate |:|II _

Connect the &AM Debugger to a Multi-ICE unit attached to target hardware, Ensure that
the unit is powered up and that the server has been configured,

] 4 | Cancel Help

Choose Target |EJE|

Figure 2-10. Debugger Configuration: Target Page
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ARM Multi-ICE ¥2.2.3 (Build 1188) ? % Q an ulfi—1CE W5 il ; 2%
Conriect |F'rucees-:-r Settings | Advanced | Board | Trace | 4] # Connect Processor Sefings | Advanced | Board | Trace | ik
Liocation of MulHCE
e Diebusg usireg e MulbHCE cornecied o
Thix i
Select & new location |or updatsl Coache clean cods sddeess

8 Chamge B seliing: fof processos
ARMIHIT on TAP B

The addimes of & 128 byba region of resdabls, =itebls
resmoip sl HulHCE uses ba clean e prossssol cachs,
and b reskart spme cones. row apolicetion nus! not use
the 1egor. The defaul & (50

| This compuber... -I firother compute |

Doaracie sebachion Add o TR IUT.
o= i Ok O0F FLOO0
i [iebasy the pracessonr = pe e
ARMIZOT en TAF O M Flexet spthem an slaiup
Selech & new procsssor |F sedected, MulHCE sl ot Sysbers Flesat vath &
— - - - b pant o sk [ wbain a dubugget connactz. Tha
= “I:-.:' This compuler wall et Bl bRy procCid0es in & Ul pIOORER0r Sphem

E TAP O ARMINT
[T Beset mecheron slatup

Conmaclon nans

ael | st | cay | Wt | Esw

Figure 2-11. ARM Multi-ICE: Connect Page and Processor Settings Page
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ABRM Multi-ICE ¥2.2.3 (Build 1188)

| Board | Trace | «1»

Target Settings
@@ i+ Little-endian
" Big-endian

| Mever uze software breakpoints

Read-ahead Cache

The read-ahead cache improves the
performance of pour debugger by caching
recently-read memon.

Iw Start-up with cache enabled

Debugager [nterface Settings

ou can select the interface used to
communizate with the debugger. Select
Atamatic for AR debuggers.

" Autornatic Currently uzing:

" RDI1S RDI 151

" RDI1ET

Iv FReport non-fatal ermors on ztartup

[2a]]

= —

i

ES

Figure 2-12. Debugger Configuration: Advanced Page
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EXECUTING 2440TEST.AXF USING ARM MULTI-ICE

1. Initialize internal variables of the debugger. After a downloading, several windows are displayed, such as
Execution window, Console window, and Command window. In Command window, you should initialize the
internal variables of the debugger, "$semihosting_enabled" and "$vector_catch", by entering the following
command:

swat $vector_catch 0x00

swat $semihosting_enabled 0x00 ;To use all H/W break points
swat psr %lFt_SVC ;To disable all interrupts
com swat psr %IF_SVC32

Or, you can initialize these variables as follows:

First, create a text file named "2440norom.ini", which includes the commands described above. Then, enter
the following command in the Command window (See Figure 2-13):

obey C:\WORK\2440\2440norom\2440norom.ini

For more information about these steps, refer to the reference document released by ARM.
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Figure 2-13. ARM Extended Debugger Window (AxD): Command Window

2. Set breakpoint at Main in 2440TEST.c as follows:
break Main

3. Execute the program by clicking Execute menu - Go. The program execution will stop at Main( ).

Now, the downloaded image file will run on SDRAM area. 2440TEST program running status can be
monitored on the DNW.
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MULTI-ICE CHECKPOINTS

1. Error messages

Refer to Error Messages of the Multi-ICE user's guide. If you cannot solve the problem by using the instructions in
the user's guide, then apply the 'Force 4-bit access" option.

Port Settings

Port &ddress
[E0TOH | Cancel
W Force 4-bit access Help

Current Part Mode
|4-bit

2. Multi-ICE current consumption problem

Multi-ICE draws the Multi-ICE operating current from a target board. The current is about 130mA at 3.3V. If the

target board cannot supply the 130mA, an external power supply must be used for supplying the current to Multi-
ICE.

3. nTRST, TMS, TCK and TDI pin connections

TMS, TCK and TDI pin must be pulled-up with 10K registers. If the Multi-ICE is not used when development is
completed, nTRST must be 'L’ level at least during the reset.
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EXECUTING 2440TEST.AXF USING ARM REALVIEW ICE (RVI)

1. Initialize internal variables of the debugger. After a downloading, several pane are displayed, such as Register
Pane, Call Stack Pane, Watch Pane, Memory Pane and Output Pane. In cmd tab of Output pane, you should
initialize the internal variables of the debugger, "@ SEMIHOST_ENABLED " and " SEMIHOST_VECTOR ", by
entering the following command:

setreg @SEMIHOST_VECTOR=0x0
setreg @SEMIHOST_ENABLED= 0x0 ;To use all H/W break points
setreg @CPSR=0xd3 ;To disable all interrupts

Or, you can initialize these variables as follows:
First, create a text file named "2440norom-rv.inc", which includes the select with window environment. More

detail inform, you can get the RealView Debugger Manual by ARM.

1. Select “Include Commands from File...” from the Debug menu.
Debug -> Include Commands from File...

2. Select “2440norom-rv.inc” file from the file open dialog box.

For more information about these steps, refer to the reference document released by ARM.

2-20 ELECTRONICS

Preliminary product information describes products that are in development,
for which full characterization data and associated errata are not yet available
Specifications and information herein are subject to change without notice.



2004.03.27

S3C2440A TOOLKIT AND DEBUGGING

HOW TO USE RealView Debugger (RVD) WITH RealView ICE(RVI)

To connect to your target hardware using a RealView ICE interface unit, you use the same RealView Debugger
features that you use for any other target. You must ensure that you use the RealView ICE target vehicle. To do
so, use the nodes in the Connection Control window that are descendents of the ARM-ARM-NW target vehicle
node, as shown as following.

When connecting, you might see the error shown as following. This error appears when the software detects that
there is already a connection to the target. This might be because someone else is connected to the target, or it
might be because a connection has been left open by software that exited incorrectly.

New target vehicle node

€+ Connection Cont.ol [mhardy\rvdebug. brd]

Hame | pescription

[ -FR ARM Ltd. EDI targets

EI-F% rver Connection Broker

[=H - ARM-HW RealViewICE

fI—- RealView ICE AFM JTAG debug interface (TCPAIPR)
@ ARMOZOT O ARMOZOT on 172.16.6.65

New access
provider node

1 I 4 I\CDI'IHBCt ,{S\,ﬂnc:]’\f‘ il _’..l
b}

\

New target node

CONFIGURING REALVIEW DEBUGGER FOR REALVIEW ICE

To debug the target board with RealView ICE(RVI), you should configure RealView Debugger(RVD). As RealView
ICE should be connected through JTAG port on the board and switched on.

To configure RealView Debugger(RVD) for RealView ICE interface, follow the steps:

1. Turn on the power (Target Board)

Ensure that the target is correctly connected and powered, then turn on the power to RVI. This will take
approximately 30 seconds. You can tell this has completed as one of the LEDs beside the JTAG connector will
come on (after first flashing, and then switching off for a short time). You must wait for this to complete.

2. Launch RVD and access the Connection Control Window
Select File -> Connection -> Connect to Target to launch the Connection Control windows.

ELECTRONICS 2-21

Preliminary product information describes products that are in development,
for which full characterization data and associated errata are not yet available
Specifications and information herein are subject to change without notice.



TOOLKIT AND DEBUGGING

2004.03.27

S3C2440A

M il Edit Find

i

File

Hot
cli

1=

41 &

Tew
Open,,,
Elnze

Ease Lags/dourmals,,,

Wiew Project Tools Debug Help

-

e

tIA e EeE EEEE

Ctil+0 ;
ey =i

Save
EanE fE,,,

Save/Close WultEle,,,

Etrl+

Connect to
k| [isconyect

Load mage,,.,
Felaad mage
Eefresth Sumt

et PE to Entry Boint Ettl+EhiftEE ASttaeh Windowoto & Connection

Disconnest
Connection
L e

Ctl=Ehift+0
to Target Etl+Es
(rl =3

<No Register Context:

Target... Alt+0
(Defiina odel, .

Alt+Cirl
Properties, .. Alt+Ehift+0
atin Cortrall,,

Erinit, .

]+

Recent Files

Fecent Workspaces
Fecent [mages

=

-

31| B4

Name I Talue

-
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Emze Window:
Exit

| cal stack {Tocals fstatics £This £ 4] I

£ [

o Nt e fera f] | o]

iI ’I'I 4 DI\Cora.r‘ J
=

41 A |5

V-S:3-1i=)
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Select target{s) to connect to

=

[Cn 1, Col'1 [

Click on the cross to the left of the ARM-ARM-NW entry to display the RealView ICE brach.

Y Connection Control (Myunghui_Ryiredebug, brd)

Help

Name |

Description

EPARH—A—RR
ﬁ ARMulator

E“SEIU’EI
% localhost

EPARH—ARH—PP

T5 ARMOAK,_MICE
EHo ARM-VILA-LE
ZEMO0T WIGGLER

AFM Ltd. BDI targets
ARM instruction set simulator
Connection Broker
Simulator Eroker
Multi-ICE direct connect
Multi-ICE direct connect [AFRM+0Oak)
MotorolasMacraigor Wiggler emulator
Macraigor Wiggler

& LRM- LRM-NI

FealViewICE

ZRealView ICE

ARM JTAG debuy interface [(TCPAIP) |
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3. Create a new JTAG configuration file
Click on the cross to expand the RealView ICE branch.

A List Selection dialogue will appear:

E List Selection
Target connection error: Could not load the file C:Program Files WA RMESY DW ored] 7
150vwyin_32-pertiumietcirvi.ryc.. See output log for details. You can:

Retry (you fix the problem first)
Edit Board-file to aive the specific pathname.
iConfigure Device Information...

Ok | Cancel | Help |

Select Configure Device Information... and click OK.

4. Configure the RealView ICE interface unit

The RVConfig dialogue should now be visible. Locate the RVI unit on the network by using the Browse button.

A. Connecting over a TCP/IP network
Click on the Browse button. The TCP/IP Browse dialog appears, and your computer starts scanning the
TCPI/IP network for available RealView ICE units, adding them to the dialog as it founds them.
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C—=RWCaonfig - C:¥WProgram FilesWARMWRYDW Care 1, P 150 win _32-pentiumWetcWrvi rvc  [[=] E3

File Wiew Help

—Connection Type

cluss |

&+ TCPAP |
IF &ddress / Host Name
| Browse, ., | |
Canmect,,, Discannect |

4
[=TCP/IP Browse
Scanning TCPAIP, .,
EFnunn:I...1
L THZTRE, T, 222 LR
[P A&ddress / Host Marme |192,1EB,1,222 <A
] atop | Cancel Help
B. When you have chosen the RealView ICE unit that you want to use, click Connect. A connection is
established to the unit.
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_32-pentiurm,., M=l

— Connection Type

) UsE I =l

Sman I

& TCP/AIP |192,IEB,I,222 <RI
IP &ddress / Host Mame

Browse, ., I
| Qonnect...l Qisconnectl

After connection, you can see the following screen.

[=RVviConfig - C:#Program FilestaRM#RYDW Coreft ], i 150 win_32-pentiumitetcifr, re =

File Miew Help
=-FealView ICE: (TCP/P 192, 165, 1,222
=R levices : ; :
L UNRHOWN Scan Chain Configuration
- Advanced T&P D | Device |0 Code  |IR Lenath | Options | Template

4| | 2
| Auto Configure Scan Chainll Device F‘mper’ties,,,l Mowve Up |

Add Device.,.l Remove Devicel Move Down |

JTaG Clock Speed

i Adaptive ¢ &GMHz ¢ &0 MHz

 20kHz & 10MHz ¢ Other 'MHZ set |

© 1MHz ¢ 20MHz

Click the Connect and then click Auto Configure Scan-Chain

Now RVI should connect to your target board: -- Generally Device with ARM cores. Now, the RealView
Debugger cannot recognize the Samsung ID code. So, you must add the new device by handcrapt.

Click Remove Device, and Add Device button.
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Now you can select the ARM core by handcrapt for your target.

(== Add Device

—Device

v Registered Devices

- ARM 10
- AR

- ERMT
Y =1 ¥ Lu]

- AR SZ5T

- AR 9ZEE -5
- AR 340T

- ARMI4EE-3
- ARM9IEEE-3
- ARMYES -5

- BRMAE-S

- AR AT

= Custom Device
Device [Mamme JUHEMNOWH
B Lenath 4 =

(1] I Cancel | Help
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C=RWiCaonfig - C:Program Filestt ARk R DM oretit], 74t B0% win_32-pentiurmittetc i, rvc =
File Miew Help
=-Realtiew ICE: (TCH/AP 132 168, 1,222
E‘ i scan Chain Configuration
e fidvanced TaP 1D | Device 0 Code IR Length | Options | Template
4| | o
Auto Configure Scan Chainl Device Propedies, ., | Mowve Up |
&dd Device,,, | Remove Devicel Mave Dawn |
—JTAG Clock Speed
¢ Adaptive  BMHz ¢ Bl MHz
 2WkHz & 10MHz © Other  [THz get |
C 1MHz ¢ 20MHz
o
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1. Configuring Device

C=PR%Config - C4%Program FilesWaRMWRYDWC oretit |, 7150 win _32-pentiurniteteiitrd, rc =
File Miew Help
'E'"H;__a[';';fi‘,fe';:E: (TCR/P 152, 168.1.222) Device: ARMS2NT using the ARMS20T template version 1:0:0
- ARMIZOT [tern Value
L Bdvanced
Code Sequence Code Address 0= 31FFFFO0
Code Sequence Code Size (= 000000FF
Code Sequence Timeout {ms) 3000

Bypass memory protection when in debug ¥ True/False

l[gnore bad JT&G IDCODE I True/Falze
Use watchpoint for software breakpoints ¥ True/False

&
Enter the value 0x33FFFF0O in the Code Sequence Code Address ltem.
Enter the value 0x000000FF in the Code Sequence Code Size ltem.
Select File -> Save before File -> Exit.
Now, save the current configuration and close the configuration dialogue.
ELECTRONICS
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%= Connection Control (Myunghui _Ryredebug, brd)

|Descriptiun

b EHDT WIGGLER
E-%ARH - ARM-NW

RealView ICE

AFM Ltd. BDI targets
ARM instruction set simulator
Connection Broker
Simulator Eroker
Multi-ICE direct connect
Multi-ICE direct connect [AFRM+0Oak)
MotorolasMacraigor Wiggler emulator
Macraigor Wiggler
FealViewICE
ARM JTAG debuy interface [(TCPAIFR)

@[T aEM9Z0T 0

APMIZ0T on 192.165.1.222

2. Connect to the target

Return to the RVD Connection Control window and expand the RealView ICE branch, then
connect to the target:

Click ARM920T_0

item.

%= Connection Control (Myunghui _Ryredebug, brd)

|Descriptiun

"%

EHDT WIGGLER
LRM-ARM-NTT
RealView ICE

AFM Ltd. BDI targets
ARM instruction set simulator
Connection Broker
Simulator Eroker
Multi-ICE direct connect
Multi-ICE direct connect [AFRM+0Oak)
MotorolasMacraigor Wiggler emulator
Macraigor Wiggler
FealViewICE
ARM JTAG debuy interface [(TCPAIFR)

ﬂFEﬂAPHSEDT 1] APMIZ0T on 192.165.1.222
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3. Confirm the connection

Now, your RVD, RVI, Target board connection were completed and you can see the following figure :

[ Elle Edit Find ¥iew Project Tools Debug Help
DEsH| ' 2B2Ea TR0 +IXEE R EEE - ([DZEZ|E
File: fNO_SOURCE Find | 7] ine: | [& v|

2 & | state: [Stopped

No source for context: <Unknomwme: ﬂ . r_E
Click to Load 'C:\workbook\RVD\intro\sessionl\DebugReldcalendar.axf! =11} 342 Bl 838795368 1=
RZ 4294967295 R3 2205
R4 342 RS 147
R& 4294967293 E7 838795368
Rd 838795368 B3 503458168
Rl0 131072 E1ll o
RlZ 4275255615 k3 8358517728
LE G696 rC 5945
CPER 2147483667
WZCW| FIQ| IRQ| STATE| MODE —
1000 ENA ENA ARM SVC
HUER
F IR
l b | <] L] 2 Pycore {15 fcache Operatians [T < i
B Hame IValue B Hoaddrs ;I
> 00 nOwTL > |<Hodddr
<0X00001AF? <Unknowm Location- <Hohddr>
<Nokddr>
<Nokddr>
<Nokddr> =
<Nokddr>
<Nokddr>
<Nokddr>
» [\ Call Stack{Locals fStatics £This /14| <Nohddr> =

> connect,route 5 ;I
» readhoard "C:\Program Files‘\ARM\RVD%Coreil.74150%win_ 32-pentium‘home’Myunghui_ Ry rvdebug. brd™

> readboard "C:\Program Files\ARM\RWD%Coredil.74150%win 32-pentium‘home’\Myunghui Ry\rvdebug.brd™
>
>

Q1

comnect, route 5
connect & JAES|@
ARM RealWView ICE
Base H/W: V1 Rev C-01
TurboTAF Rev: 1.00
Firmware: 1.1.0, Beta, Build l2&
Copyright APRM Limited 2002,2003
Attached to stopped device
Warning: No stack/heap or top_of memory defined - setting top_of mewmory to OxS0000.
(|Mode: Little Endian
Stop-

cmd & Sl £ Build £ FileFind £ SrcCirl £*Log

0]

[
For more information, select Help fram Manu [Ln 1. Col 1 [
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HOW TO USE ARM DEBUGGER WITH OPENICE32-A900

Followings explain how to download the compiled image to SDRAM memory on the SMDK2440 by ARM debugger
through OPENice32-A900, an emulator for ARM processor.

CONFIGURING ARM DEBUGGER FOR OPENice32-A900

To debug the target board with OPENice32-A900, you should configure ARM Debugger for Windows (ADW) or
ARM Extended Debugger (AxD). As MULTI-ICE, OPENice32-A900 should be connected through JTAG port on the
board and switched on.

To configure ARM Debugger for OPENice32-A900 interface, follow the steps:

1. Select Configure Debugger from the Options menu.
Options -> Configure Target

2. Debugger Configuration dialog box is displayed (See Figure 2-14). If there is no OPENice32-A900 in the target
environment box, then you have to click on the Add button and select OPENice32-A900.DLL.

— ARMulator: lets you execute the ARM program without any physical emulator by simulating ARM
instructions in software.

— OPENIce32-A900: connects the ARM debugger to OPENice32-A900 attached to the target board.

3. Select OPENice32-A900 from the Target environment box, and click the Configure button.

Choose Target

Target Environmments

Bemowve
Rename
Save As
Configure

You can use the ARM Debugger with OPEMice32,
This suplﬁurtg all functions of ARM debugger
but semihiosting,

()4 | Cancel | Help

Figure 2-14. Debugger Configuration: Target Page
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4. ConfigureOPENice32-A900 dialog box (See Figure 2-15, 2-16).
— Remote page: select the connection to OPENICE32-A900.

OPEHIce32-A900

Rermmote Set

i~ Serial

i~ Ethernet

ver. 1.41 for ADW & AXD

Part

Remote ]Dehugger] SMU | Flash config | Help |

Baud Rate

2l |

Address

‘12?.

Set IP Address ‘

o, o1

Get |P Address

[

=H0|

==l

Figure 2-15. OPENice32-A900 Configuration: Communication Setting Page

— Debugger page : set the Endian and decide where initializes S3C2440A without any boot ROM.
Endian : little (If the big endian is used, Endian: big has to be selected.).

It should be matched with the option that you set in the compiler.

To init SMU : If you want to initialize S3C2440A on the board without any boot ROM, check it and set
SMU in the SMU page, (Don'’t check it in this application.)

Flash download : If image file will be downloaded to a flash device, check it and set options in the
Flash config page. (Don’t check it in this application.)

OPEHIce32-A900

Bytesex
" Big Endian
& T :

> Endiar

ver. 1.41 for ADW & AxD

Jtag Clock 10 MHz

Debugger
(=

Remote Debugger | SMU | Flash config | Help |

[~ Toinit SMU, Check!
[~ Flash download

t« A0S 1.0 or more (rdi 1,610

3

Figure 2-16. OPENice32-A900 Configuration: Endian and SMU Setting Page
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— SMU page: set SMU of S3C2440A. Select SMDK2440 or S3C2440A from the device name and modify the
values.(No need to set it in this application). SMU of S3C2440 is the same as S3C2410. So, if you cannot
find S3C2440 from the device name, then you may select SMU of S3C2410 instead of S3C2440.

OPENIced2-A800 wer. 1.41 for ADW & AXD

Remate | Debugger SMU | Flash config | Help

Device name |&3C 2440 | 41  Dev, Updste |

Mo | Register Address Valug | #Hrib, | Size | ~
o L
02 INTHMSE 43000004 11117) (I o
03 INTSLUB#MSEK 4a00001c W AW 4
04 LOCETBAE 4000000 ittt B 4
05 MPLLCON 4000004 S0E0 RW 4
06 EWSCON 45000000 0 BYW 4
T BANECOND SE0C000 i AW 4
08 BAMECOMI 45000008 D B 4
13 BANKCONMNZ SE00000: i AW 4
11 BAMECONZ 453000010 o B 4
11 BAMNKCOMN 4000014 T R 4
12 BAMECOME 453000IE o B 4
13 BANECONG 480000« g AW 4
14 BaMECONT 45000 e Bw 4
I3 REFRESH Paed sc0 BRAW 4«

: Mew . Add I:Ielate-|
i | |

Figure 2-17. OPENice32-A900 Configuration: SMU Setting Page

— Flash Config page: set options for Flash download. (No need to set it in this application).

OPENIce32-A900 ver. 1.41 for ADMW & AXD

Remote | Debugger | MU Flash config ]Help |

Device |Am29L\B00BE | [~ Download
Erasze Data bus width
i~ Sector{Block) & Chip (= i« 1Bbit " 32hit
AddressiHex)
Flash base (00000000
A&k base |30000000 RAM size |3FFFFFF

= &

Figure 2-18. OPENice32-A900 Configuration: Flash Configuration Setting Page
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5. If you click the OK button on Choose Target dialog box (See Figure 2-19), the debugger will be restarted. The
restarting dialog box is displayed and numbers are rapidly changing, indicating that it is reading and writing to
the target. This means that the executable image file is downloaded to the SDRAM code area.

Choose Target Ej@

Target Environments

Targat | RDI | File | Mersion | Add
alP 1.1 o whBinWwHemnote_a.dll 1.2.0.805
ARMUL 151 Co . WBinwARMulate, di 120,837 Rermoue
FMulti-ICE 1,51 Cir, JIi"'i'lf‘---"lLll’[l [CE.dll 2.2.3,1188 =
- UHenlcedd 1,5,1

R Iiﬂ”"""-”‘t"]ll___h__. L 5 '.'1 - Iy HEHEIITlE
aave b
Configure

environment to the list, Mote that a target environment has to be configured at

i Please select a tar?et environment from the abowe list or add a target
[
\‘\') least once before it can be used,

]9 | Cancel Help

Figure 2-19. Debugger Configuration: Choose Target

This configuration is initially done and the setting is saved, which relieves the user of repeating another
configuration next time.
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EXECUTING 2440TEST.AXF USING OPENICE32-A900

1. Select Load Image from the File menu and select the compiled image (2440TEST.AXF). Then it will be
downloaded to the SDRAM on the board.

Execute the program by select Go from the Execute menu.

Now, the downloaded image file will run on SDRAM area. 2440TEST program running status can be
monitored on the AXD.

Al [ALIEDN) — C2WYHLEEWS 302 4IRS 2840 T aat-pUSE 244807 aai Mos D000 24 8851, ]

Fle Seamh ProcessorViews Syglem Views Execule Oplions  Window Help - B M
FS | e o o |eF) Gl | G | DB PREED |Boe@maEE | el B@e) o
Target | image | Files | Class
[ el AL |
ALIKDG = Ragisgians M2 EE] {wald *|Rre_Teat, "RTC Tesr - =

- a3 wald ") [Tk Test, "Ik Tast a
| Reegtarac Talie a0 {waid *|Tuat_4DI, TE past
S-Curzent {---1] a1 (wold ¥|Teat_kdc, TADC Test =
tl [ 3005SECEL a2 (wadd ¥ Teat_hdeTr, TARC TE bawk -
Tl [ 30O0E ZDAL 93 (wald *|Teat Time=z, "TimeT TEST i
L2 eD0DOoonn kL
= [t S00E SHAL 95 0.0
rd [=00DDO0ED :g bz il
Lk e 00D000DE ag I ———
ot 00000000 o
£7 xFEFFFFFF 1
T3 [=DDO00DDD 1l woid Madn(wodid]
I3 =FFFFFFFF P 102
i fOOOOOAN 103 int ir
cll IOODOOODD tg-:- unsigned int mpll_wal;
e NN LG Lad_Diaplayp(iet| ¢
Tl D= A3FFSAnn 107 =
eld D= 30000244 Lon A5 BN inat, LD cache on. =1
P 300004249 . g —
| 3]
Syedem Lt Moniios
A Log | Dabug Leg
Log file:
OFE a3 4500 i, 141 dppeited b S0 5 pstain Ca Ll 5 Konea -~
Litfs Ereisn.  Coneesctll SB Prat SO AN
Fawvsare Ve 1.75 -
4 *
For Help, press Fl Lime 102 Col D OPenlceIz ALNCOH 24d0est aaf

Figure 2-20. ARM Extended Debugger (AxD): After Downloading
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DEBUGGING DOWNLOADED IMAGE IN ADW OR AXD

Stepping Through Program
To step through the program execution flow, you can select one of the following three options:

— Step: advances the program to the next line of code that is displayed in the execution window.

— Step Into: advances the program to the next line of code that follows all function calls. If the code is in a called
function, the function source is displayed in the Execution window and the current code.

— Step Out: advances the program from the current function to the point from which it was called immediately
after the function call. The appropriate line of code is displayed in the Execution window.

Setting Breakpoint

A breakpoint is the point you set in the program code where the ARM debugger will halt the program operation.
When you set a breakpoint, it appears as a red marker on the left side of the window.

To set a simple breakpoint on a line of code, follow these steps:
1. Double-click the line where you want to place a break, or choose Toggle Breakpoint from the Execute menu.

The Set or Edit Breakpoint dialog box is displayed.
2. Set the count to the required value or expression (The program stops only when this expression is correct).

To set a breakpoint on a line of code within a particular program function:

1. Display a list of function names by selecting Function Names from View menu.

2. Double-click the function name you want to open. A hew source window is displayed containing the function
source.

3. Double-click the line where the breakpoint is to be placed, or choose Toggle Breakpoint from the Execute
menu. The Set or Edit Breakpoint dialog box appears.

4. Set the count to the required value or expression (The program stops only when this expression is correct).

Setting Watch Point

A watch point halts a program when a specified register or a variable, which is set to a specific number, is about to
be changed.

To set a watch point, follow these steps:
1. Display a list of registers, variables, and memory locations you want to watch by selecting the Registers,

Variables, and Memory options from the View menu.

2. Click the register, variable, or memory area in which you want to set the watch point. Then, choose Set or Edit
Watchpoint from the Execute menu.

3. Enter a Target Value in the Set or Edit Watchpoint dialog box. Program operation will stop when the variable
reaches the specified target value.
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VIEWING VARIABLES, REGISTERS, AND MEMORY

You can view and edit the value of variables, registers, and memory by choosing the related heading from the View
menu:

— Variables: for global and local variables.
— Registers: for the current mode and for each of the six register view modes.

— Memory: for the memory area defined by the address you enter.

DISPLAYING CODE INTERLEAVED WITH DISASSEMBLY

If you want to display the source code interleaved with disassembly, choose Toggle Interleaving on the Options
menu. This command toggles between Displaying Source Only and Displaying Source Interleaved with
Disassembly. When the source code is shown interleaved with disassembly, machine instructions appear in a
lighter gray color.

For additional information about ARM Debugger, refer to the reference document released by ARM.
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DEBUGGING DOWNLOADED IMAGE IN REALVIEW DEBUGGER(RVD)

Select File Load Image... from the Code window main menu to load an image to a processor for execution. This
displays the Load File to Target dialog box shown as following

21
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This dialog box contains controls to configure the way the image is loaded for execution:

Symbols Only

By default, any object file loaded from this dialog box also loads the symboils. If you want to load only the
symbols then select this check box, for example when you are working with ROM images.

If the program was initially compiled without a symbol table then you must recompile the program before
loading only the symbols.

Replace Existing File(s)

By default, loading a new image overwrites any image currently loaded to the target.
If you are working with multiple applications, use this check box to carry out separate loads of associated
modules such as an RTOS and associated applications.

Target Name:

Use this field to enter the target name, where supported.

A name entered here is then used as the argument to a LOAD command (see Specifying the load
instruction).
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Arguments:

PC

Use this field to enter a space-separated list of arguments to the image.

Entries in this field create an arguments list used with the LOAD command (see Specifying the load
instruction).

When you load an image to the debug target you can optionally set the Program Counter (PC):
Auto-Set PC

Selected by default, this control defines the location of the PC when you load an image. RealView
Debugger tracks the state of the other check boxes on this dialog box and sets the PC at the
normal entry point, if you select the check box Replace Existing File(s).

Unselect the Auto-Set PC check box to have control over the PC when you load an image.
Set PC to Entry point

Where selected, RealView Debugger sets the PC at the start address specified in the object
module.
This is the default if you select both:

Auto-Set PC
Replace Existing File(s).

Unselect the Set PC to Entry point check box to prevent the load command setting the PC.

If you have started RealView Debugger and are connected to a debug target, you can load an image for execution
from the Process Control pane:

1.

Select View -> Pane Views -> Process Control Pane from the default Code window main menu to display the
Process Control pane.

Whilst there is no image loaded, the pane only shows details about the debug target processor and the current
location of the PC.

Right-click on the top line, the Process entry, to display the Process context menu.
Whilst there is no image loaded, you can also display this menu from the Image entry.
Select Load Image... to display the Load File to Target dialog box.

Complete the entries in the dialog box, described in Using the Load File to Target dialog box, to load the
required image.
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EXECUTING 2440TEST.AXF USING REALVIEW ICE(RVI)

1. Select Load Image from the File menu and select the compiled image (2440TEST.AXF). Then it will be

downloaded to the SDRAM on the board.

Execute the program by select Go from the Execute menu.

Now, the downloaded image file will run on SDRAM area. 2440TEST program running status can be
monitored on the RealView Debugger (RVD)
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- File Edt Find Yew Project Tools Debug Help
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Figure 2-21. RealView Debugger (RVD): After Downloading
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SWITCHING DEVELOPMENT TOOLKIT
USB boot code (U2440mon.c) and test code (2440test.c) can be executed in the SDT or ADS by changing the

option in OPTION.H and Makefile. In other words, boot and test code can be translated from ADS to SDT and vice
versa by changing option in the following table.

Table 2-1. Toolkit Switching Options

ADS SDT
Makefile fromelf -nodebug -bin -output $(PRJ).bin fromelf -nodebug -nozeropad $(PRJ).elf -bin
$(PRJ).elf $(PRJ).bin
OPTION.H | #define ADS10 TRUE #define ADS10 FALSE

TRANSLATING CODE FROM ADS INTO SDT

U2440MON and 2440TEST codes were optimized for ADS 1.0. In other words, these codes were compiled and
linked by the ADS 1.0. So, these codes should be modified to work on the SDT.

If you want to compile our codes with the SDT, then you have to change the definition of ADS1.0 in OPTION.H

from 'TRUE' to 'FALSE' and the option in makefile from 'fromelf -nodebug -bin -output $(PRJ).bin $(PRJ).elf' to

'fromelf -nodebug -nozeropad $(PRJ).elf -bin $(PRJ).bin’ option.

TRANSLATING CODE FROM SDT INTO ADS

First function __rt_lib_init(); is applied to the main code. And then old Makefile for SDT is changed to a new one for
ADS.

If you have used SDT 2.50, it is recommended that you should read related documents (ADS, Getting Started, and
ARM DUIO064A) about the difference between SDT 2.50 and ADS 1.0.

REMOVED OR CHANGED ITEMS FROM MAKEFILE FOR SDT 2.50
1. ARMLINK option

— first: the path of an object file is not needed.

2. ARMASM option
— cpu: should be changed as -cpu ARM920T
— apcs: should be changed to -apcs /noswst

3. Compiler option

— fc : should be removed.

— zpz0 : should be removed. This is not needed any more.
— apcs : should be changed to -apcs /noswst

— processor : should be removed.

— arch : should be removed.

— cpu : should be added as -cpu ARM920T

4. fromelf.exe
— nozeropad: should be removed. This is not needed any more.
— output : command line style should be changed using -output option as follows:
fromelf -nodebug -bin -output $(BIN)\$(PRJ).bin $(BIN)\S(PRJI).AXF
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OTHER ITEMS SHOULD BE CHANGED FOR ADS 1.0

1. ammake.exe
The armmake.exe is not supplied with ADS 1.0. So, you have to use your own Make utility.
(nmake.exe, make.exe, pmake.exe, or armmake.exe in SDT 2.50).

2. Embedded library
There is no separate embedded library in ADS 1.0. All the library in ADS 1.0 is made for embedded
applications.
But, the library must be initialized using __rt_lib_init() function. If you do not use __rt_lib_init(), the C library
does not work well.

3. There is no tasm.exe. The tasm.exe is merged into armasm.exe.
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EXAMPLE OF MAKEFILE FOR ADS 1.0
This is a sample makefile on ADS 1.0.

#it## File Definition ####
PRJ = 2440test
INIT= 2440init
AM1 = 2440slib
AM2 = 2440swis
CM1 = 2440lib
CM2 = mmu
CM3 = 2440iis
CM4 = timer
CM5 = 2440RTC
CM6 = 2440I1I1C

CM38 = spi
CM39 = strata32

##HH# Destination path Definition ####
OBJ=.\obj
ERR=.\err

#i# ARM tool Definition #####
ARMLINK = armlink

ARMASM = armasm

ARMCC =armcc

### Option Definition ##H#H

LFLAGS = -ro-base 0x30000000 -elf -map -xref \
-list list.txt -first $(INIT).o(Init)

AFLAGS = -li -apcs /noswst -cpu ARM920T

CFLAGS = -c -g+ -li -apcs /noswst -cpu ARM920T

#H# Object combine Definition ####

OBJS =$(OBJI)\$(INIT).0 $(OBI)\$(AM1).0 $(OBI)\$(AM2).0 $(OBINS(PRJ).0 \
$(OBJ)\$(CM1).0 $(OBJI)\$(CM2).0 $(OBIN\S(CM3).0 $(OBJI)\$(CM4).0 \
$(OBJ)\$(CM5).0 $(OBJI)\$(CM6).0 $(OBIN\S(CM7).0 $(OBJI)\$(CM8).0 \
$(OBJ)\$(CM9).0 $(OBJ)\$(CM10).0 $(OBINS(CM11).0 $(OBI)\$(CM12).0 \
$(OBJ)\$(CM13).0 $(OBI)\$(CM14).0 $(OBI)\$(CM15).0 $(OBIN\S(CM16).0 \
$(OBJ)\$(CM17).0 $(OBJI)\$(CM18).0 $(OBI)\$(CM19).0 $(OBIN\S(CM20).0 \
$(OBJ)\$(CM21).0 $(OBI)\$(CM22).0 $(OBI)\$(CM23).0 $(OBIN\$(CM24).0 \
$(OBJ)\$(CM25).0 $(OBJ)\$(CM26).0 $(OBI)\$(CM27).0 $(OBIN\S(CM28).0 \
$(OBJ)\$(CM29).0 $(OBJI)\$(CM30).0 $(OBI)\$(CM31).0 $(OBINS(CM32).0 \
$(OBJ)\$(CM33).0 $(OBJI)\$(CM34).0 $(OBI)\$(CM35).0 $(OBIN\S(CM36).0 \
$(OBJ)\$(CM37).0 $(OBI)\$(CM38).0 $(OBI)\$(CM39).0
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all: $(PRJ).axf

clean:
del $(OBJI)\*.0

$(PRJ).axf: $(OBJS)
del $(PRJ).bin
del $(PRJ).axf
$(ARMLINK) $(LFLAGS) -0 $(PRJ).axf $(OBJS)
fromelf -nodebug -bin -output $(PRJ).bin $(PRJ).axf

#For SDT2.5 fromelf -nodebug -nozeropad $(PRJ).elf -bin $(PRJ).bin
#For ADS1.0 fromelf -nodebug -bin -output $(PRJ).bin $(PRJ).elf

$(OBINS(PRJ).0: $(PRJ).c 2440addr.h 2440lib.n makefile
del $(OBJ)\$(PRJ).0
del $(ERR)\$(PRJ).err
$(ARMCC) $(CFLAGS) $(PRJ).c -0 $(OBJI)\$(PRJ).0 -Errors $(ERR)\$(PRJ).err

$(OBINS(CM27).0: $(CM27).c 2440addr.h 2440lib.h makefile
del $(OBJ)\$(CM27).0
del $(ERR)\$(CM27).err
$(ARMCC) $(CFLAGS) $(CM27).c -0 $(OBI)\$(CM27).0 -Errors $(ERR)\$(CM27).err

$(OBI\S(CM28).0: $(CM28).c 2440addr.h 2440lib.h makefile
del $(OBJ)\$(CM28).0
del $(ERR)\$(CM28).err
$(ARMCC) $(CFLAGS) $(CM28).c -0 $(OBI)\$(CM28).0 -Errors $(ERR)\S(CM28).err

$(OBINS(CM29).0: $(CM29).c 2440addr.h 2440lib.h makefile
del $(OBJ)\$(CM29).0
del $(ERR)\$(CM29).err
$(ARMCC) $(CFLAGS) $(CM29).c -0 $(OBJI)\$(CM29).0 -Errors $(ERR)\$(CM29).err
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PROGRAMMING FLASH MEMORIES

PROGRAMMING NAND FLASH MEMORY

The SMDK2440 supports NAND flash control interface. There are only one methods to write images to NAND
flash memory:

— Write image files to NAND flash memory with write-program.
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NAND FLASH WRITE WITH WRITE-PROGRAM
The target image must be downloaded in SDRAM before executing write-program.
To download and write a target image from the host to SDRAM through USB interface, follow the steps:

1. Runthe DNW utility program (See Figure 3-1).

D ok G0 [COR-x] IUSE: k]
Serial Part  UEE Port Confguration Help

Figure 3-1. DNW Window to Download

2. Select Serial Port on the system menu of DNW and click Connect to open the serial port (See Figure 3-2, 3).

DM w508 [COMx] TUSD:K] B

Saiisl Poey  USE Port Configuration Help

Tran simit l

Figure 3-2. DNW Window (to Connect Serial Port)
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-l DNW v0.504 [COMI.115200bps; [USB:x] =13
Serial Port USB Port Configuration  Help

Figure 3-3. DNW Window (after Open Baud-rate is Printed on Title Bar)

3. Connect the serial and USB cable from the host PC to SMDK2440 system and turn on the power of
SMDK2440 board (See Figure 3-4).

NOTES:
1. Jumper J1-B, J2-B, J3-B, J4-B must be ‘H’, ‘'L’, ‘L’ and ‘H’ for AMD NOR Booting.
2. SMDK2440 must run monitor program that is provided by SAMSUNG.

-/ DNW v0.50A [COM1,115200bps] [USB:OK] M=
Setial Port USB Port Configuration Help
Fa
F—————— +
| 33C2448X USE Downloader ver RB.81 2883 HMay |
e +
FCLE=192HHz ,DMA mode
USBE: IH ENDPOINT:1 OUT_EHDPOINT:3
FORMAT : <ADDR{DATA) t4>+{SIZE(n+18) 4> +<DATA:N>+{C5:-2>
HOTE: 1. Power offfon or press the reset button for 1 sec
in order to get a valid USB device address.
2_ For additional menu, Press any key.
USB host is connected. Waiting a download.
=
Figure 3-4. DNW Window (after Turning on the SDMK?2440)
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4. To see the additional menu, press any key on the DNW window (See Figure 3-5).

=l DNWY »0.504 [COMI1,115200bps] [USB:0K]

(=1

Serial Port USB Port Configuration Help

FCLK=192HHz ,DHA mode
USB: IH EHDPOINT =1 OUT_ENDPOINT:3
FORHAT: <ADDR{DATA) :4>+<SIZE{n+18) :4>+<DATA:n>+{C5:2>
HOTE: 1. Power off/on or press the reset button for 1 sec
in order to get a valid USB device address.
2. For additional menu, Press any key.

USB host is connected. Waiting a download.

i Select Henu H#HHGEHE
[8] Download & Run
[1] Download Only
[2] Test SDRAH
[3] Change The Console UART Ch.

Figure 3-5. DNW Window to Download

For downloading a target image, select Download Only item on the DNW window (See Figure 3-6).

Write the address to download and press enter key (See Figure 3-6).

NOTE: The target image must be located on 0x30100000 address.

| DNW viLEDA  [COMIL1 1 EAIDbps] [USEOK] =13
aenal PFad  USH Pedt Configuration  Help

e,

FCLE=192HHz ,DHA mode
UEB: IH_EHDPOINT:1 OUT_EHDFOIHT:=3
FORMAT: <ADDR{DATA) :Bx+<S12E (n+10) cBx={DATA N>+ {05 223
HOTE: 1. Fower offfon oF press the reset button for 1 sec
in arder Eo get a walid USE deviee address.
2. For additional menu, Press anyg key.

UsE host is connected. Waiting a download.

puinER Select Memu BEHNHE
[B] Download B Run

I7] Download Dnlyg=

[2] TeaT CORAA
[4] Change The Console DART Ch.

bownload Dnly is selected.

Enter a mew tenporary download addreess(@ed.. .5 307 Baag

Figure 3-6. DNW Window (to Select Target Image)
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7. Select USB Port on the system menu of the DNW and click Transmit to download a target image
(See Figure 3-7).

OHW w504 [COMI115200bps] [USEOE]
Seral Poet | USE Pod  Configuration  Help

HOTE: 1. or press the reset button For 1 sec ~
i Tasd get a walid WEH device address.
i Shas al nenu, Press any key.

UEE host is connected. Waitimg a download.

HHHRERE Select Menu ERHHDE

[8] Bownload & Run

[1] Download Onliy

[2] Test SDRAH

[3] Change The Console UART Ch.

Download Only is selected.
Enter a new temporary dounload addreess(@8x3. . ) Gud 000008
The temporary download address is Bxdod A00EA.

fUsE host is connected. Waiting a download.

b
Figure 3-7. DNW Window (for USB Downloading)
8. Select a target image on file open dialog box (See Figure 3-8).
 DNW 0,504 [COMI.115200bps] [USE:OK] (=]

&= fH(): | D MeBoot-loader > 4= @y -

s MMdllaadar bin
lH #H=2M

—

(g

b £

=/

22X

lHﬁEI
LH u:gﬂ

3]

O DImcM): [FedDlpadar. bin ﬂ | 2 I
THE T B e bl El a2 |

Figure 3-8. DNW Window (File Open Dialog Box)

ELECTRONICS 3-5

Preliminary product information describes products that are in development,
for which full characterization data and associated errata are not yet available
Specifications and information herein are subject to change without notice.



2004.03.27

PROGRAMMING FLASH MEMORIES

S3C2440A

9. For downloading 2440test program, select Download & Run item on the DNW window and download
2440test program like step 7 (See Figure 3-9).

Download
Enter a n
The tempao

=l DNW vD.504 [COMI1.115200bps] [USB:OK]
Setial Port | USE Popt Configuration Help

EBX

Transmit cted.
Rx Test download address{8x3...):8x38100000
Status d address is Bx3818808064.

USB host is connected. Waiting a download.

How, Downloading [ADDRESS:381080088h,TOTAL Z3282]
RECEIUED FILE SIZE: 3282( 41 _.BKB/5,8.15)
How, Checksum calculation

Download 0.K.

i Select HMenu HEHEHEH
[1] Download Only
[2] Test SDRAH
[3] Change The Console UART Ch.

Figure 3-9. DNW Window (File Open Dialog Box)
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-/ DNW v0.504 [COM1,115200bps] [USB:OK] = EX
Serial Port USB Port Configuration  Help
Fat

[SHDK2448 Board Test Program Uer 8.8]

[Fclk:Hclk/Pclk]=[488.08:133.3:66.7 JHhz

[Uclk=48.8Hhz]

B:User Test 1:Manual Reg Set 2:PCHMCIA test 3:Stepping stone

4:Hand test L:Program Flash 6:DMA test 7:Interrupt test
8:Power/Clk test 9:Lcd test 18:Camera test 11:3P1 Test
12:1IC Test 13:RTC Test 14:IrDA Test 15:8D test
16:ADC test 17:ADC TS5 test 18:Timer test 19:11I5 test
28:Uart Test
Select the function to test (::)
Hand test
Select Hand flash type, Hurmal(1}fﬂduanced(2}(:::)
K951288 Hand flash test start.

B:Read ID 1:Hand reset 2:Block erase d:Page read

4:Page write 5:Hand R/W test 6:Check Badblock 7:HMand Block lock

8:50ft Unlock 9:K951288 Program
Select(-1 to Exit

[SHC{K951288UBH) HAHND Flash writing program]
The program buffer: B8x30100000~0:231FFFFrff
Source size:8h™8h
Available target block number: B@~4895

Input target block numbey: 5

Figure 3-10. DNW Window (2440test Program)

10. Write '5’ and press enter key on the DNW window (See Figure 3-10).
11. Select Nand flash type (See Figure 3-10).
12. Write '4’ and press enter key on the DNW window (See Figure 3-10).

13. Write the target block number that is the start block to write and press enter key on the DNW window
(See Figure 3-11).

14. Write total byte size of the target image, it should be aligned 0x4000 (one block size) bytes (See Figure 3-11).

NOTE: 2440test program supports normal NAND flash type (K9S1208: SmartMedia card, SAMSUNG) and advanced NAND
flash type (K9K2G16: SAMSUNG). To write another type of device, it is required to modify the source codes
NAND.C(normal K9S1208) or K9K2G16.C(advanced K9K2G16).
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ol DNW v0.504 [COMI,115200bps] [USB:0OK]
serial Port USE Port Configuration Help

EER

@:Read ID 1:Hand reset 2:Block erase
4:Page write 5:Hand R/W test 6:Check Badblock
8:5o0ft Unlock 0:K9%51288 Program

Select(-1 to exit): 9

[SHC{K9512B8UBH) HAND Flash writing program]
The program buffer: B:30100000™0x31FFFFFF

Source size:8h™Bh

Available target block numher' 4695
Input target block numbe

Input program file 5129(h ES
File:16384[1-block,B-page,B-bytesT.

@:Read ID 1:Hand reset 2:Block erase
4:Page write 5:Hand R/W test 6:Check Badblock
8:5o0ft Unlock 9:K931288 Program

Select(-1 to Exit}:(:g
SHC{K251288UBM) HAHD Page Read.
Block # to read: @

Page # to read: @

Read DK.
Read data{8-block,B-page)

B: 74 B8 A0 ea 52 OO 60 ea 57 A0 A0 ea 62 60 B0 ea
18: 5b 08 08 ea fe ff ff ea 47 B0 68 ea 40 00 00 ea
208: 68 068 60 ea 11 ee 18 6F 88 e3 86 B8 81 ee 18 BF
38: ff ff fF fFf ff £Ff £ £F tF £F £F fF £F £F £F £F
LA: £f £Ff fF ff 63 B0 A0 ea B8 28 af e1 B8 A0 18 e3
CA: BFf 668 60 1a by A0 9Ff o5 08 38 98 o5 A2 168 a8 el
68: 48 18 81 e3 60 18 88 5 18 18 af e3 81 18 51 e2?

J:Page read
7#:Hand Block lock

J:Page read
7#:Hand Block lock

Figure 3-11. DNW Window (NAND Flash Write Program)

15. To check the contents of NAND flash, select Page read function (See Figure 3-11).
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AUTO BOOTING THROUGH NAND FLASH

The S3C2440 supports auto booting operation with NAND flash memory.

Before power on the SMDK?2440 system, it must have SmartMedia card with boot-loader and OS image.

NOTES:

1. Jumper J1-B, J2-B, J3-B, J4-B must be ‘L’, ‘L', ‘L’ and ‘L’ for NAND Booting.

2440test program and boot-loader, which is supplied by SMSUNG, support normal NAND flash type (K9S120:
SmartMedia card, SAMSUNG) and advanced NAND flash type (K9K2G16: SAMSUNG). To write another type
of device, it is required to modify the source codes NAND.C(normal K9S1208) or K9K2G16.C(advanced
K9K2G16).

BOOTING NAND FLASH

To make NAND flash memory for auto booting, follow the steps:
1. Program the boot-loader image to the block 0 of NAND flash memory.

2. Program the OS image to the other blocks of NAND flash memory. The OS image must be located block 1 to
the rest blocks.
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NAND FLASH ECC (ERROR CHECKING AND CORRECTION)

The S3C2440A supports ECC algorithm, which is based on XOR calculation, for error checking and correction.

1. Example of one byte ECC (find error bit)

old Old ECC code
D7 | D6 | D5 | D4 | D3 | D2 | D1 | DO P3 |NP3| P2 | NP2 | P1 | NP1
1 0 0 0 0 0 0 0 1 0 1 0 1 0
New New ECC code
D7 | D6 | D5 | D4 | D3 | D2 | D1 | DO P4 | NP3 | P2 | NP2 | P1 | NP1
1 1 0 0 0 0 0 0 0 0 0 0 1 1
S3 [NS3| S2 |NS2 | S1 | NS1
Old ECC * New ECC 1 0 1 0 0 1
P3 = [7]N6]1'[5]"4] NP3 = [3]"[2]"[1]"[0]
P2 = [7]N61N3IM2] NP2 = [S]"[4][1]Y[0]
P1 = [7]N51MB3IM] NP1 = [6]"[4]"[2]"[0]
P3 NP3 P2 NP2 P1 NP1
Old 1 0 1 0 1 0
New 0 0 0
(Old ECC) ~ (New ECC) 1 0 1 0 0 1
Error code 1 1 0
Result Bit 6
NOTES:

1. [n] means bit [n] (or Dn).
2. The’'10b’ value of ‘Old ECC ~ New ECC’ corresponds to ‘1b’ Error code and ‘01b’ corresponds to ‘Ob’.
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2. Example of n byte ECC

D7 D6 D5 D4 D3 D2 D1 DO
Oth byte [7]0 [6]0 [5]0 [4]0 [3]0 [2]0 [1]0 [0]0
1st byte [711 [6]1 [5]1 [4]1 [3]1 [2]1 [1]1 [0]1
2nd byte [7]2 [6]2 [5]2 [4]2 [3]2 [2]2 [1]2 [0]2
3rd byte [7]3 [6]3 [5]3 [4]3 [3]3 [2]3 [1]3 [0]3
509th byte [71509 [6]509 [5]509 [4]509 [3]509 [2]509 [1]509 [0]509
510th byte [71510 [6]510 [5]510 [4]510 [3]510 [2]510 [1]510 [0]510
511th byte [7]511 [6]511 [5]511 [4]511 [3]511 [2]511 [1]511 [0]511
— Column parity (CPn)
CP3 = NCP3 =
[7107 [712N[ 7127713 ... N[7]5097 71510771511 [3]07 [311M3]27[3]3" ... ~[3]5093]51073]511
N[6]0M [6]11[6]27[6]3" ... N[6]5097[6]5107[6]511 N2]0M2]1M2]272]3... AN2]5091[2]51072]511
A[5]0" [5]17[5]27[5]3" ... A[5]5091[5]51075]511 AN1]ONL]ANL]2MN1]3N ... M[1]50911]5107[1]511
N4]10N [4]1MN4]27N4]3N ... N4]5097[4]51074]511 A[0]0N0]1M0]270]3 ... A[0]50910]5107[0]511
CP2 = NCP2 =
[710M [712N[ 7127713 ... N[7]5097 71510171511 [5]0" [5]27[5]2M5]3" ... N[5]5095]5101[5]511
N[6]0” [6]17[6]27[6]3" ... A[6]5091[6]51076]511 N4]0N [4]1M4]12M4]3N ... M4]509/4]51074]511
AN[3]07 [3]1M[3]27[3]3" ... M[3]5091[3]51073]511 NLJOMNA]IN1]2M[1]3” ... M1]50911]51071]511
N2]0M2]1M2]12742]3R... M2]50912]51072]511 N[0]0OMN0]1M[0]27[0]3 ... ~[0]509/0]51070]511
CP1= NCP1 =
[7107 [712N[ 7127 7]13N ... N[7]5097 71510171511 [6]0" [6]17[6]26]3" ... N[6]5096]5101[6]511
A[5]0" [5]1M[5]27[5]3" ... A[5]5091[5]51075]511 A [4]07 [4]1M4]274]13 ... N[4]5097[4]5107[4]511
A[3]0M [3]11M[3]27[3]3 ... N[3]5091[3]51073]511 A [2]0M2]11M2]1272]3... M[2]50912]51012]511
A[L]ONA]IMNL]127N1L]3N ... N[1]5091[1]510M[1]511 A [0]07[0]1M[0]270]3 ... A[0]5094[0]5101[0]511
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— Row parity (RPn)

RP9 =
[7]5117[6]5117[5]5114]5117[3]5117[2]511[1]5117[0]511

N[7]3847[6]3847[5]384/[4]384/[3]384/[2]384"[1]3847[0]384
N[713837[6]3837[5]383"[4]383"[3]383"[2]383"[1]383~[0]383

N

N[7]2567[6]2567[5]256"[4]256/[3]256"[2]256"[1]256"[0]256

NRP9 =
[7]2557[6]255"[5]255/4]255[3]2557[2]255"[1]2557[0]255
AN[7]1287[6]1287[5]128"[4]128"[3]1287[2]128"[1]128"[0]128
N711277[6]1277[5]1274]1277[3]1277[2]127[1]1277[0]127

N

"{7]0"[6]0"[5]0"[4]0"[3]0"[2]0"[1]0(0]0

RP8 =
[7]5117[6]5117[5]5114]511[3]5117[2]511[1]5117[0]511
N[7138476]3847[5]384"[4]384/[3]384/[2]384"[1]384/[0]384
[7]2557[6]2557[5]255"[4]255[3]2557[2]255[1]2557[0]255

AN

N[7]128[6]1287[5]128"[4]128"[3]128"[2]128"[1]1287[0]128

NRPS8 =
[7]3837[6]383"[5]383"[4]383"[3]3837[2]383"[1]383"[0]383
N[7]2567[6]256[5]256"[4]256/[3]2567[2]256"[1]256[0]256
N[711277[6]1277[5]1274]1277[3]1277[2]127[1]1277[0]127

AN

"[7]07[6]0"[5]0"[4]0"[3]0"[2]0*[1]0"[0]0

RP1 =
[7]5117[6]5117[5]5114]511[3]5117[2]511[1]5117[0]511
N715097[6]5097[5]509[4]509[3]5097[2]509[1]509/[0]509
N7150776]5077[5]5077[4]507[3]507/[2]507[1]507~[0]507

AN

M7]1NB]INS]1NA]1M[3]1M2]17[1]1M[0]1

NRP1 =
A[7]51076]5107[5]5104]5107[3]5107[2]510[1]5107[0]510
A[715087[6]508"[5]508"[4]508[3]5087[2]508"[1]508"[0]508
N[715067[6]506"[5]506"[4]506"[3]5067[2]506"[1]506"[0]506

AN

"[7]0"[6]0"[5]0"[4]0"[3]0"[2]0"[1]0"[0]0
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3. Example of 4 bytes ECC (find 1bit error in the 4 bytes)

— Old data
D7 D6 D5 D4 D3 D2 D1 DO
Oth byte 0 0 0 0 0 0 0 0
1st byte 0 0 0 0 0 0 1 0
2nd byte 0 0 0 0 0 0 0 0
3rd byte 0 0 0 0 0 0 0 0
— New data
D7 D6 D5 D4 D3 D2 D1 DO
Oth byte 0 0 0 0 0 0 0 0
1st byte 0 0 1 0 0 0 1 0
2nd byte 0 0 0 0 0 0 0 0
3rd byte 0 0 0 0 0 0 0 0
— Column parity
CP3 NCP3 CP2 NCP2 CP1 NCP1
Old data 0 1 0 1 0
New data 1 1 0 1 0 0
(Old ECC) ~ (New ECC) 1 0 0 0 0
Error code 1 0 1
Result 5th bit
— Row parity
RP3 NRP3 RP2 NRP2
Old data 0 1 0
New data 0 0 0 0
(Old ECC) ~ (New ECC) 0 1 0
Error code 0 1
Result 1st byte
— Result: The 5th bit in the 1st byte is in error.
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PROGRAMMING NOR FLASH MEMORY

The SMDK2440 supports NOR flash control interface. There are two types of NOR flash memories in SMDK?2440:
AMD and Intel STRATA flash memory. The actual methods:

— Write image files to AMD flash memory with UART.

— Write image files to AMD flash memory with Multi-ICE.

— Write image files to AMD flash memory with RealView ICE(RVI).

— Write image files to AMD flash memory with OPENice32-A900

— Write image files to Intel STRATA flash memory with UART.

— Write image files to Intel STRATA flash memory with Multi-ICE.

— Write image files to Intel STRATA flash memory with OPENice32-A900

WRITING IMAGE FILES TO AMD FLASH MEMORY WITH UART

1. Connect MULTI-ICE and execute “ 2440norom.ini “ file.
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2. Load the image file (2440TEST .axf) to execute.
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3. Execute 2440TEST code with Go command.
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4. Select " 6:Program Flash ” on the DNW.

NOTE: If you want to download 2440TEST.bin without MULTI-ICE, then skip the 1, 2 & 3 steps above and download
2440TEST.bin using the DNW (See EXECUTE 2440TEST WITHOUT MULTI-ICE).
After download 2440TEST.bin with the DNW, then you can also see the figure below.

sl DNW v0.504 [COMI,115200bps] [USB: OK]

serial Port USE Port Configquration  Help

[SMDK2448 Board Test Program Uer 8.8]

[Fclk:Hclk/Pclk]=[283.2:101.6:50.8]Mhz
[Uc1k=48_6Hhz]

G:User Test 1:Manual Reg 3et 2:PCHCIA test 3:Stepping stone
4:nWAIT test S:Hand test 6:Program Flash 7:DHA test
8:Interrupt test 9:Cpu speed test 18:Power/Clk test 1:Lcd test
12:Camera test 13:5P1 Test 14:1IC Test 15:RTC Test
16:1rDA Test 17:58D test 18:ADC test 19:ADC TS5 test
28:Timer test 21:11I3 test 22:Uart Test 23:C1lkdiv_Test

Select the function to test

[ HOR Flash Memory Writer Uer 8.1 ]

program buffer : B8x310086808 ™~ O0x33fFfO000
AM29LUBBBBE x1 b : 28F128J3A{16HB) =2
a flash memory ? |
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5. Select the type of memory as AM29LV800BB x1 (AMD Flash) by typing ‘a’.
6. Select whether you download through UART or MULTI-ICE.
— Type 'y’ then you can download target files through UART. See the figure below.

| DNW v0.504 [COM1.115200bps] [USB:OK] =]

Serial Port USB Fort  Configuration  Help
[SHDK2448 Board Test Program Uer B.8] »

[Fclk:Hclk/Pclk]=[283.2:101.6:50.8]Mhz
[Uclk=48_6Hhz]

G:User Test 1:HManual Reg 3Set 2:PCHCIA test 3:Stepping stone

L:nWAIT test L:Hand test 6:Program Flash 7:DHMA test

8:Interrupt test 9:Cpu speed test A1@8:Power/Clk test 11:lcd test
12:Camera test 13:5PI Test 14:1IC Test 15 :RTC Test
16:IrDA Test 173D test 18:ADC test 19:ADC T3 test
28:Timer test 21:11I% test 22:lart Test 23:Clkdiv_Test

Select the function to test : &

[ NOR Flash Hemory Writer Uer 8.1 ]

The program buffer :© Ox31008888 ™~ Bx33fF0008

a : AM29LUSBBBE =1 b : 28F128J3N{16MB} =2

Select the type of a flash memory ? a

Do you want to download through UARTA from Bx3188886887 [usn]

downloadAddress = 3108006806808

Download the plain binary file{ .BHC) to be written
The file format : <n+6>{4)+{n)+C5(2)

To transmit .BIH file : wkocm? xx%.BIN 71 /fd:1
Download methods - COM:8Bit,HP,1STOP

STATUS :
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7. Download target files with the DNW by selecting Transmit menu from Serial Port.
— Serial Port 2> Transmit

_ DNW v0.50A  [COMI1,115200bps] [USE:OK] (=] E3
Serial Port USE Fort Configuration: Help
[SHDKZY42 =] @
Eﬁ:ﬂ = 217 [ 24400SB Mon > « ®@ef e

clk=4§

_ uZddlmon, bin

9:User L@

h:nWal LH &2 =M

g:Inte -
12 :Came [
16:IrDA HIEF S
20:Time
Select Li-r—é—])d
[ NOR FY 45z
The prog -
a : AM2Y
select LH HEHZ A
Do you

ojz OIS {u2440man, bin | =710
downloat T Ed AT ; v =
1 e T . * 3 - =| i

Boubinas = (I |BIN Files {+ bin:+ nb0) -] %]
The file Format : <n+b +{n)+L5(7)

To transmit .BINH file : wkocm2 x==x.BIH /1 /fd:1
Download methods : COM:8Bit . HP,1STOP

STATUS =

— Select and Download a target file.
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= DNW v0.504 [COMI.115200bps] [USB:0OK]
Serial Port USB Fort Configuration  Help

Select the Function to test : &

[ HOR Flash HMemory Writer Uer 8.1 ]

The program buffer : 8x31088008 ™ B8=33ff0000

a : AMZ29LVUBBOEB =1 b : 28F12BJ3A(16HB) =2

Select the type of a flash memory 7 a

Do you want to download through UARTH from Bx318868887 [y/n] : y

downloadAddress = 3100080048

Download the plain binary file{.BHC) to be written
The file format : <n+6>{4)+({n)+C5(2)

To transmit .BIH file : wkocm? xxx.BIH 71 /d:1
Download methods : COM:8Bit _ HP,1STOP

STATUS @ #nususssdsidddgid gttt g i
Download 0.K.
[AM29F8B8 Yriting Program]

CAUTIOH: Check AM22LU888 BYTE#{47) pin is connected to UDD.
Source size:Bh™BaS4h

Available Target/Source Address:

Bx8, Bx4000, Ax6000, Bx8000,0:10000,0<20000,08x30000,0:<40000,
x5 80008, 8x60000, 870000, 080000, 0x20000, 8200008, BxbAA60, BxcBBB0,
8xdBeA8, Bxed000, BxFO000
Input source offset[8x0]:

8. Write input source offset and target offset and type 'y’ repeatedly until the source size is reached.
The example below shows how to setting source offset and target offset. The size of target file is 0x8a54
bytes.

— Write source offset * 0x0 ' and write target address ‘ 0x0 ', and then type ‘y'.
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NHW w508 [COMI 1 EADhg ] [LUSA:OK]

Gerled Pad BB Post  Laonfigeration Melp

fawrce size;

ilanle Targek c® Address:
B, Sxh@on, Ded0E, ScH@@, B 0000, B2 BB, @000, iy aase,
IS DEBE, fh @000, e DODD, BA0R9E, QxR ON0D, o B00d, SxLUann, lac DEbe,
Id DEDE, dp@0ad, dxf DDDD

Ingut souroe nFFﬂt[HI]@
Input target address asan U m:::qnn@
target addresz=ixi

target block sire=RakABB
[Check AWZELUEEN]

dactiuce Ib=  1{EBBEp, Device IB[BE225H}=225%0

Fase The Sechor: .
sctor Erase is sbarted?

tart ofF Ehe dabs ssiting.
0 1B6S 288 3000
nd of the dats weitingfrt

rifying Stark.
0 libd ddd Gada

ifying Endids
Yo want anotiber progranndng withset additional oowslead?
[AEI9Famd Writing Praqram]

I0H; Check AHIFLUSER BYTER(LT) pim i= connecked be 900,
TRIEDH g 2

ilable Targetfisurce Address:

il, @xaddd, NeSODD, HOEE, Bx1 000D, 2 e, deIaann, ek Dhbe,
DS ONDE, #aih 00l 0 000D, S Ad0dd, Axonnn, ixa e dubuann, n&c Db,
D BRBE e 3000, Oxf 000D
Input source DFFsEL[ kDbl m
Input target address among o Eslhnlll
squrce nfFsek=Tckiin
Larget address=lzkiiin
Larget block sipe=ia3BnBn
[Eheck AH2VLUEENR]

Factiure 1bh= 1B, Devioek IB]MEII5H p=2250

— Write source offset * 0x4000 ’ and write target address ‘ 0x4000 ', and then type ‘y'.
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— Write source offset * 0x6000 ' and write target address ‘ 0x6000 ’, and then type ‘y'.

0 1n6R

ifying Endt1e

you want anobker prograsadng witbset additional desslead? [uin]
[aPCOFAES Writing Pragram])

[0H: Chieck AHFFLUSDD BYTER(WT) pim is conneched Do W00.
e slze @RSk

lable Target/Ssarce Address;
B, Sxhlin, Medhff, ScHI@D, e DAAA, D SRR, B ANNNN, R b BERS,
T BEBE, 80 SRAN, ke OAAA, B0 200, B IITNN, B S08a, Bxchilin, lae BHSE,

Inpul souree nFFut[hilﬂn

Ingut targot agdress amang Hns[ua-ﬂ-
£e offsobeGxs0nn

target address=ionon

target block sizesBc2non

[Check ANZRLURNA]

Punufacture 10=  1[BeBBBI}, Device 1B(Be2Z50}=225h

drise The secbhor: S HEE.
Beetor Erase is sbarted?

Start of The data weiting.
0 100
nid of the data writing¥tf

Efying Cnatey
yau want aneliéc programidng wileeel additional dewslead? [Usn)
[ FEEE Writing Fragram)
[0H: Check BHIFLUSDR BYTES{LT) pim is connecbed be 900

e size ;BN RSE

ilable Targetfisarce Address:

Bel, SxAEEN, UsSOEB, SH@@E, Ml 000, B Eeed , @i, by nnes,
TS BEEE, 26000, e D000, 8 HIR00, BxPunnn, B sddd dx=buiinn, e anny
Nad DRBE, <2000, D F DRDD
Input source oFFset|ieEn):
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— Write source offset * 0x8000 " and write target address * 0x8000 ', and then type ‘n’.

End of the data weitinmgttt -

Uerifying Stark.

o 1866

Uprifyping Encd®tt

Do you want another progranming withoot additional download? [ysn]
[AMZYFERA Writing Frogram]

CAUTIOM: Check AMZ9LVEBR BYTEH(AT) pln is connected to UDD.
Source size:dh™BaSuh

fAuailable TargetSSource fddress:
BB, GxLPOE, BxAA00, @xBO0E, 010000, G DO0E, Bx3 0000, Bx s DBBAE,
x5 BA00, B DBAEA, Bx 7 AA00, BxEOBAA, Bx9A000, Bxa DOOE, BxhAAO0, Bxc OO0,
Hd BO0R, e DRAE, B F AODH
Input source ofFfset[0xE000 ”‘m
Input target address among afere-Tddresses| Bx“l:ln
soUrce OFFset=0xEmag
target address—0<8000
target block Size-dxB00D
[Check AMZILUAEA]
Hanufacture 0= 1{fxBRE1), Device ID[Ax225E)=2250

Erase the sector:Bxiinn.
sector Erase is started?

start of the data wreiting.
0 1800 2200 3800 4200 5000 S00Q TOHAA
End of the data weitimgttt

Uerifying Start.

0 1860 2086 3060 LBE0 SA08 dROE FRAE

Uerifying Endtt?

o you want another progranming without additional download?

B:lUser Test 1:Manual Reg et 2:PCHCIA test J:5tepping stone
L:nUAIT test 5:Mand test G:Frogran Flash T:DMA test
A:Interrupt test 9:Cpu speed test 1@:Power/ClE test 11:Lcd test
12:Camera test 12:3PI Test 14:1IC Test 15:RTC Test
16:I-DA Test 17:50 btest 18:nDC test 19:A0C TS test
20:Tiner test 21:11I5 test 22 zlart Test 23 :Clhkdiv_Test

Select the function ko test :

9. Turn the SMDK2440 off and then on.
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WRITING IMAGE FILES TO AMD FLASH MEMORY WITH MULTI-ICE

1. Connect MULTI-ICE and execute “ 2440norom.ini “ file.
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2. Load the image file (2440TEST .axf) to execute.
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3. Select Load Memory From File... on the file menu of AXD.
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— Get atarget file to 0x31000000 in SMDK2440 Board.

Load Memory From File @
=AM [ 2440USB_Mon ~| « @ cF E-

bin

OFE OIS N {u2440man, bin 207
I EAT: Al Files (=) -] 54
Address: 10331 Q0o00a

Froceszors

_
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4. Execute 2440TEST.axf file with GO command.
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5. Select " 6:Program Flash" on the DNW.

NOTE: If you want to download 2440TEST.bin without MULTI-ICE, then skip the 1, 2 & 3 steps above and download
2440TEST.bin using the DNW (See EXECUTE 2440TEST WITHOUT MULTI-ICE).
After downloading 2440TEST.bin with the DNW, then you can also see the figure below.

=)
=erial Port USB Port Configuration Help
[FSTATUS3=8] A

[SHDKZ2448 Board Test Program Uer B.8]

[Fclk:Hclk/Pclk]=[2983.2:101.6:50.8]Hhz
[Uclk=48_8Hhz]

B:User Test 1:Hanual Reg Set 2:PCHMCIA test 3:Stepping stone

L:nWAIT test L :Hand test 6:Program Flash 7:DHA test

g:Interrupt test 9:Cpu speed test 18:Power/Clk test 11:Lcd test
12:Camera test 13:5PI Test 14:1IIC Test 15:-RTC Test
16:1rDA Test 17:5D test 18:ADC test 19:ADC TS test
208:Timer test 21:11I5 test 22:Uart Test 23:Clkdiv_Test

Select the function to tESt

[ HOR Flash HMemory Writer Uer 8.1 ]

program buffer : 8x310808008 ™~ 0x33ffO0000
:]AMZ9LUBABBE =1 b = 28F128J3A(16HMB) =2
ect the type of a flash memory ? a
Do you want to download through UARTA from Bx318888887 [u/in] :

6. Select the type of memory as AM29LV800BB (AMD) by typing ‘a’.
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7. Select whether you download through UARTO or MULTI-ICE.

— Type ‘'n’ then you can see the figure below in the DNW.

[} (. 504 [} 0b
merial Port USB Port Configuration Help

-

12:Camera test 13:5PI Test 14:1IC Test 15 :RTC Test o
16:IrDA Test 17 :5D test 18:ADC test 19:ADC TS test
28:Timer test 21:11I5 test 22:lart Test 23:Clkdiv_Test

Select the function to test : 6

[ HOR Flash HMemory Writer Uer 8.1 ]

The program buffer : B8x310086886808 ™~ Bx<33ff0000

a : AMZ9LURABBE =1 b : 28F128J3A(16HB} =2

S5elect the type of a flash memory ? a

Do you want to download through UARTA from Bx3108068087 [uin] - n
[AH29F8A8 Writing Program]

CAUTIOH: Check AM29LUSA0 BYTEH#(47) pin is connected to UDD.
Source size:Bh™8h

fivailable Target/Source Address:

8x8, 8xh4080, Bx6000, 0=<8000,0:10008,0:20000,0x30000,0x40000,
Bx50000, 0x60000, Bx7 0000, B:80000, 990000, 0xaB000, BxbA0vA, Bxc 0800,
BxdBBee, Bxed0B0, B 0000
Input source offset[8xz@]:

3-30 ELECTRONICS

Preliminary product information describes products that are in development,
for which full characterization data and associated errata are not yet available
Specifications and information herein are subject to change without notice.



2004.03.27

S3C2440A PROGRAMMING FLASH MEMORIES

8. Write input source offset and target offset and type 'y’ repeatedly until the source size is reached.
See Writing the image file to AMD Flash memory with UART.

rifying itart.
0 1bdd

ifping Endttt
you usst anokbher programnisg without additionsd down]osd? @
[AFUTREN Weiting Pregram)

TIOH: ChecH NHEFLYGDE BYTER(AT) pin §5 connecbed to UDE.

rie sl BH™8h

ilable TargqetfSeerce Address:
B, DakbiR, OwE00R, SxEOOD, bOQE00, 02 A0, 0] DREd, SxDDDE,
P B3R, M ARBR, e T ANAR, S:ROONN, BRAAON, KA P20, Mhwh ABE, e NARE,

Thadl B39, llxe DBBY, B NOBE

IRpUT Giwarde nﬂ:rt[uiﬂ@

Input Earget address among auumu—:ﬂullll
target sd@ress=@xE00R

target bleck sires=ladnng

The data mest be dewmloaded ecing ICE Fram 31900000
[Cheok WHIFLUE ]

uFactwre [D= 1 Rebidd ], Bewice 1BQBa225H)=FEF5h

rase Dhic Seclor :deS0ng.
#otor Erdde 15 croartedt

tart of the data writing,
0 USEE POO0 88 WOND SEdd AMND Fédd
nd of Dk data writingtTr

ifping Stark,

0 O1ERE FHOR D823 hOOA S8R9 ANNR Feea

rifying Endtty

you wast another progrannisg without additional downloas® [uin]

B:lser Test 1:Manual E=q 5Pk T:PCHCIR test ¥:5tepping stone
HnWWIT Lest SoFand Eesl &:Progran §lash FioEnR Eesk
#:interrept tect  P:Cpu cpiid Test  1i:PowerfElR test  11:led Test
1iCamsra test 1¥:5P1 Test 1k:[IC Test 15:ATC Test
1§:IrDA Test 17:50 Eest 1§:A0C Eest 1¥:80C TE best
FR:Tiner test F1:015 Bext F2:lart Test FR:E1kdiv_Test

Seloct b Function te Tosr @

9. Turn off and on the SMDK2440.
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WRITING IMAGE FILES TO AMD FLASH MEMORY WITH REALVIEW ICE(RVI)

To use RealView Debugger to control Flash memory on your chosen debug target, you must:
® Configure your debug target to describe the Flash memory chip
® Have access to an appropriate Flash MEthod (FME) file.
Depending on your current target, this might mean that you must first define the memory map to specify the Flash

memory.

Flash definition files

Files to enable you to use supported Flash devices are included in the root installation and are located in
c:\work\2440\Flash directory. Files are collected in subdirectories based on the target Flash device:

Board-specific files

The board_amd_smdk2440.ame file was contain the ASCII format information for an FME file.
These files include Flash memory programming files.

Flash-specific files

These programming files start with flash_amd.ame.

These files contain the algorithm for defining the Flash device and are used to create the FME file for your
project.

To see how these files are used:

1. Start up RealView Debugger without connecting to a target.

. Select Project -> Open Project... to open the project c:\work\2440\flash\flash_amd_smdk2440.pr;j
. Select Project -> Project Properties... to display the Project Properties window.

. Left-click on “*ASSEMBLE=arm” and “*COMPILE=arm” in the List of Entries and , the left pane. This group is
expanded and the contents are displayed in the Settings Values pane, the right pane.

A WD

5. Right-click on *Sources and select Explore from the context menu.
This shows the programming file used to create the FME file for the project.

6. Left-click on *BUILD in the List of Entries. This group is expanded and the contents are displayed in the Settings
Values pane.

7. Right-click on *Pre_Post_Link and select Explore from the context menu.
This shows the link commands used to include the Flash definition files for the project.
8. Select File -> Close Window to close the Project Properties window without making any changes.

9. Select Tools -> Build to create the FME file as defined by the project, that is flash_amd_smdk2440.fme.

Flash Method files

FME files include code to:
® Enable you to write to the Flash on your debug target
® Perform read, write, and erase operations

® Describe the way the Flash is configured on the bus.
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Example files are included for all supported Flash devices as part of the root installation.

Defining your target

To configure the Flash target:

1. Start up RealView Debugger without connecting to a target.

2. Select File ->Connection -> Connect to Target... to display the Connection Control window.

3. Right-click on the entry RealView-ICE and select Connection Properties... from the context menu.

This displays the Connection Properties window where you can view configuration settings stored in your board
file.

4. Click on the entry CONNECTION=RealView ICE, in the left pane, to display the settings values in the right pane.
5. Edit Connection Properties
Select the Advanced_Information>Default>Memory_block
And, Create the AMD-Flash, SDRAM, SFR(Special Function Register) memory area for debugging.
»  Start
— 1st Address of Flash (0x0)
* Length
— Length of Flash Area (0x100000)
Access
— Flash
Flash type

— FME file path (c:\work\2440\flash\flash_amd_smdk2440.fme)

[EE Connection Properties : =10l =]

File Wiew Help

E | Description: |Define an externaliASIC memary region

b s rvbroker.brd ;I Hame Jalue
H(*.hcd] Board/Chip Def:
[ *CONNECTI ON=AFMOAE, MICI

[0 attributes

€3 *CONNECTION=TEL_MICE EEQISEEI—PDS—LEH
(1*CONNECTION=MOT WIGGLE] Atart Ox0000
—H_1*CONNECTION=RealView II *Length 0= 100000

+E) *Connect_with $ Type default

EiRenote ® *hccess Flash
= *advanced Informatio Wait states ]
y ; ] — |l *F1ash type "Cohvworkh 24408 Flashy £lash amd smdkz2440. fme™
Appllcatmn—l":'ad s‘ﬁ Description "From ASIC/Board”

% Volatile

- IMap rule il
4 | 3

For more information, select Help From Menu MR i
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6. Change your top of memory variable for your target. Because, this flash program using this setting value for
stack. So,. You must change this value.

ﬂE Connection Properties = | I:Ilﬂ
File Wiew Help
E | Description: |Cl:unfiguraticun for ARM processor use
*Memory_block ;I Hame Jalue
*Mﬂ)—FlaSh 1 stack Heap
*3DRAN & =
+SFR Vectors
IjHap_rulE 5] Semihosting
[(Regizte r_enum 0 armulator
#{IReqister *Top memory 0x 30800000
[dcone at Register *F Vector catch #True
#H_JPeripherals # Properties
IjREgister Windonr
Eifapn config |
Logic_dnalyzer
Cross_trigger
BirTos
1 *CONNECTI OH=VPE9Z6ET-3
-
1| | 3
For more information, select Help From Menu ML i

6. Select File -> Save and Close to close the Connection Properties window.
7. Connect to the target using the Connection Control window.

8. Select View -> Pane Views -> Memory Map to display the Map tab in the Process Control window, where you
can see the Flash memory on the SMDK2440.

9. Starting the RealView Debugger and connect RealView ICE with SMDK2440.

And, execute “ 2440norom-rv.inc” file by “Include Commands from File...” of “Debug” menu.
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_D:ARM-ARM-NW I [ |
I Ble Edit Find Wiew Project Tools Debug Help

DSH ' BEANTFHPEOFH +IX S8l REE  ([DEE
File: [$MO_SOURCE Fint | N i

@ | State: IStopped

i‘Jo source for context: <Unknowc: ;I
Click to Load Image to Target RO 0oo0nooon Rl 0ooonoooo
RE oopooooo R3 oooooooon
R4 oopoolol RE 30024C54
R& 300&653DC r7 30024E30
RE 30065403 Ra 30024F2C
EL0 30065428 R11  300Z50Z0
El1Z 30065459 P oooooooon
LR oopooooo rc 30000068
CPEE 000000D3

wzC¥| FIO| IR0| STATE| MODE

0000 DIS DIS ARM Ve

f\Dsm j Src il v 4|\ core fcP1s fCache Operations £ TLE Operatia 4 | o

?

Hame | Ualue B[ Hame | Value B[ onaars ;I
~ | N |

<Nodddr
<Hodddrs
<Modddr>
<Nolddr>
<Hodddrs
<Modddr>
<Nolddr> —
<Hodddrs
<Modddr>
<Nolddr>
<Nokddr>
<Hodddr>
S <Molddr>
<Nokddr>
<Noaddr» |

41 A

Call Stack 4] » wsicht Sich2 Jatchs fwatchd 7 4] |

Memory Controller Setupincs SETMEM /32 0x43000000=0x22000000 ;I
inck SETMEM /32 0x43000004={ (0<LC13)+ (001 + (748 ) + (001 +(0<Cd) + (0<L2) +0)
ince SETMEM /32 Ox48000008={ {0<<13)+{0<<L1)+{ 7<<8) +{0<<6 ) + [ 0<<4) + [ 0<<2) +0)
ince SETMEM /32 0x4800000c={ {0€<13)+{0<CLl)+{ 7<<8) +(0€LE ) + [ Do<d) + [ 0<<2) +0)
inck SETMEM /32 0x43000010=( (0<LC13)+ (001 + (748 ) + (001 +(0<Cd) + (0<L2) +0)
ince SETMEM /32 Ox48000014={ {0<<13)+{0<<L1)+{ 7<<8) +{0<<6) + [ 0<<4) + [ 0<<2) +0)
ince SETMEM /32 Ox48000018={ (0<<13)+{0<CL1)+{ 78] +(0<LE ) + [ D<) + [ 0€<2) +0)
inck SETHMEM /32 0x480000Llc=((3<<15)+(0<<2)+1)

ince SETMEM /32 Ox48000020=( (3<<15)+{0<<2)+1)

ince SETMEM /32 Ox48000024= [ (1<<23)+{0<<22)+{0<20)+ [ 14<18) +(2<<16) +1113)
inck SETHMEM /32 Ox48000028=0x31

ince SETMEM /3& Ox4800002c=0xE0

ince: SETMEM /32 Ox48000030=0x20

Include file (0) C:h\work'2440%2440norom-rv.inc completed.

41 @

Stop> ]
[ I

For more information, select Help fram Menu Ln 1, Col1 IW ’7
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10. Select the “Upload/Download Memory File...” of “Debug -> Memory/Register Operations” menu.

[ RvDEBUG = @ARMSZOT_0:ARM ARM W -1o] x|
"0 Fle Edt Find View Project Tools | Debug Help
| 0O = u| % B2 | ™ [ Execution Control 3 | & | B - ||E|E‘E| ] <& | State: [Stopped
H— - Simple Breakpoints 2
I | [ERE SEIEE Flnd:l Complex Breakpoints 2 '|
{|No source for context: <Unknow Tra int: 2 =&
| Click to Load Image to Target r Operations  # Sek Memary, .. RO oooooooo El gooooooo
= Patch Assembly. . Rz 00000000 R3 00000000
Include Commands from File. ., Set Register.. B4 00000101 B5 30024054
et Jourez Jearch Pif... Upload/Download Memory file... L1l e el
Add/Edit Debugger Macros. .. Fill Memary with Pattern... i3t el oo i) sl o ol
R10 30065429  R11 30025020
Flash Memary Contral, .. RlZ 30065459 5P 00000000
LE 00000000 I 30000068
CPSE 000000D3
HZCY| FIQ| IRQ| STATE| MODE
ooo0n DIS DIS ARM | BVC
H TSR
H IR
HFIO
EHave
[H AET
[ D
i o|i» m e ﬂ le <| >|\ Core £CP15 ,(Cac:he Cperations )<TLEI Operaﬂoﬂ j
You can see the Upload/Download file from/to Memory window.
Now, we must change the options for flash writing.
mUpluad,.-"Duwnluad file from,;/to Mem il

i+ Load File irto Memory
{ Save Memory into File
" “erify Memaory and File

File: I Ciweorki24 40244 0man-rey02-200401 26W2440man ki ] |

raweh - Rawy data one byte per byte of memary

Location: I 00 j
[Location iz start address far readiverity) ﬂ
w

Agply | Cloze | Help |

Specify the operation and set up the controls, as follows:

® Select the Load File into Memory radio button. This instructs RealView Debugger to access the
specified memory block, write the contents to flash memory.

In the File text box, enter the full pathname of the file to use to read/write memory values.
In the Type of File section of the dialog, select the data type to be used in the specified file where:

B OBJ specifies an object file in the standard executable target format, for example ARM-ELF
for ARM-based targets
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raw specifies a data file as a stream of 32-bit values

rawhw specifies a data file as a stream of 16-bit values

rawb specifies a data file as a stream of 8-bit values
ascii specifies a space-separated file of hexadecimal values.

® Define the start location of the memory block.

11. Click Apply to create and write the specified file.

You can see the following figure after changed option. If you didn’t change that you must get some problems
during write the image on your AMD flash.

E|Flash Memory Control : x|
Flazh: | I ARMIZOT 0 ARM-ARM-RW st 00000 AMD AM29LYE00 Bottam Bo

—Open Flash Blocks:

0: 00000 bytes in, Ox4000 byte block.
1: 04000 bytes in, 0x2000 byte block.
20 0x6000 bytes in, 0=2000 byte block.
3 0x8000 bytes in, 03000 byte block.

AllCn | .ﬂ-.IIOffl

'l.-“-.l'r'rtel Erasel Cancel | Detailsl Cancel All |
[T Erase Block hefore wWirite

[ &erify Block atter Write

| Usze Current values for Unspecified data in black

Flash Log:

Flash block 3 opened for modify . ;I
Fla=zh block 2 opened for modify.
Flazh block 1 opened for modify .
Flash block O opened for modity .

Close Helgp |

12. Before writing the image on your flash, you must erase the flash.
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mFIash Memory Control

E]Flash Memory Control

Flash: | I ARMIZ0T_0: ARM-ARM-BY &t 00000 A0 AM28LYE00 Bottom Bo

—Open Flash Blocks:

=MC FLASH OPEMED=

—Open Flash Blocks:

1: 0%4000 bytes in, 0x20

2 0xB000 bytes in, Ox200

[0 0x0000 bytes in, 04000 byte block,

00 hyte block.
00 byte block.

3 0x8000 bytes in, 08000 byte block.

|

=hane=

[~ Erase Block before Yirite
[~ “erify Black after Wiite

el | Details | _cancel al |

Alon | ot |

I rasel Cancel I Details' Cancel Al

| Erase Block befare Wit
[ “erify Block after Vurite

! se Current walugs for Unsgecified data in block [ Use Currert values for Unspecified data in block
Fla=h Log: Flash Log:
Erasing block O &t address 00000 ﬂ WWiriting to Flash block 1. d
Erazing block 1 &t address Ox4000 WWiriting to Flash block 2.
Erazing block 2 &t address OxE000 WWiriting to Flash block 3.
Erazing hiock 3 &t address 05000 Flazh programming complete.
Flazh programming complete. Opened Flash closed (last block closed).
v -
Cloze Helg Claze Help
Now, your flash was completed writing. Please, reset the your target.
You can see the following figure after finished the flash writing function.
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tol DMWY w0508 [COM1,115200bps][USE:x=] _ -10] x|
Serial Pork  USE Port  Configuration  Help

DIUN UPLL® [«
HPLLUal [H:fb6h,P-dh,5:8h]

CLEDIUN:3h

e *

| S3c2448% USB Dowvnloader ver RB.681 20883 Hay |
e *

FCLE=283_.2MHZz ,DMA mode
USB: IH EHDPOIHT:1 OUT_EHMDPOIHT:=3
FORHMAT: <ADDR{DATA) - 4%+{SIZE(n+18) 4> +<DATA:N>+{C5 22>
HOTE: 1. Power offfon or press the reset button for 1 sec
in order to get a valid USB device address.
2. For additional menu, Press any Key.

USB host is not connected yet.
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WRITING IMAGE FILES TO AMD FLASH MEMORY WITH OPENICE32-A900

OPENIice32-A900 can write image to AMD Flash memory as Multi-ICE. However, OPENice32-A900 provide a

Flash Write Program that is easy to use and don’t require ARM SDT/ADS debugger nor DNW.

1. Connect OPENice32-A900 to PC through USB and to SMDK2440 board with 20pin Cable.

2. Run the Flash Write program and select Connect MDS from the File menu.

Eide iy Flach el

¥ £ 0

[ ot

o

3. Select SMU Manger from the utility menu and choose a device file, SMDK2440. It is used to initialize the
system registers in case of there is no boot ROM. If you can't find the file, download the device file SMDK2410

instead of SMDK?2440. After that, edit each value if necessary.

Skl manager IE|

Devica  [SMOK244D

-

|'.-f-.d|:-'dr.-'il:e i

ko, Ragher nema Address Valug Size Al

1 WTIODM SO0 QQoogooo 4 Fitvtd
£ FTMEFE, e N o o o o o v
3 HTEUBEMEF L460000C  Q000OFFF 4 Faivid
4 LOCKTIME 42000000 QOFFFFFF 4 R
3 MFLLCIR SCONOO04  0QOSCnEE 4 Fitvtd
& EveSC0ed S0 2N 4 Fafvid
¥ BAMECOMD SE00000E Q0000700 A Fuivd
g BARKCONT SSQOOCE  QQooovoo 4 Fitvtd
4 BAMECOMN Sguioon, ooy 4 Pl
10 EaMECOMI SO0 Q0000v00 4 Fuivid
11 BAMKCORNA #0004 00000700 4 R
12 BAMKCOMNS snQoms  ogoogion. 4 Fifvtd
13 BaMECOME S0nc  (0Ems 4 Fatvid
14 BAMKCONT S0 Q0FB00s 4 Fuivd
L= | g ] == W) =g gt nNaEmaco 4 [ =3 T R

SEve Cloze
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4. Select Config.. from the Flash menu and Set the write options as followings

Config target

Device : |SMDK244D j v Set SMU
AR infarmation (Hex) Endian

Base Addr|30000000  Size |03FFFFFF " Big i+ Little

File 1 ]Fnez | File 3 | File d(Length(4byte)+File+ CheckSurn) |

v Dowhload Flash device |ﬁm29LVBDDEIEI j
Data width Erase Flash address{Hex)

Ak * Chip Base (00000000

& 16hit " Sector Target |IIIIIIIZIIIIIZIIZIIZIIZI

C 32hit  MNone rase size |

Target Image File:
iC:\WCIRKHEéI4D‘.,244EIUSEI_MDH'\U244Dm|:|n.bin

5] 4 Cancel

— Device: SMDK2440

— Set SMU: Checked

— RAM Information: Base Address:30000000 Size: 3FFFFFF
— Endian: Little

— File 1 page
Download: checked
Flash Device Name: AM29LV800BB
Erase:Chip
Data Bus width: 16bit
Flash Address: Base Address: 0 Target Address:0

— Target Image File: u2440mon.bin
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5. Click OK. Then the current configuration is displayed in the window.

Fka Lk Feah  Shod

[EE W K ASI

* Cwrrent ety .
| Lt SHBETdAR
FAM iss BCESE n; oduiutuduital
FAN size ok HFFFFFF
Byte son LAGELE mlllam
Filed contiyg
FLEN maine AncHH hlbEE
Exarit ALL
Bats s width 1€ Fit
Flash eide D SFF [enreeeee e )
Target wWMTesS et e )

Target imepe Tile CoVIRIO 240N FLAMEEE Mk d dodeas . im

* Darremt Camiiy T
B i SHBE 8
Pl feaie SiiCES# e Toiniulejuleiel
Fill #ize ok HFFFFFF
Eyte wem Littlie emliiam
Filed camtiy
FLarkl el Al T lbEE
Eraise ANE
Bata bas width 1% Fit
FLarbl ke SebirE-24 SwduEeueu el
Target sidress SnedmEnSningaaal

Target imape Tile oI 2 SR M . i

1Z oo i £
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6. Select Write from the Flash Menu. Then it starts to erase the specified area of AMD Flash and write the image

to the Flash memory. It takes about 10 second.

Bk Uk Fesh  ghod

[ W £ A=l

* Curremt Centiy .
e ioe Sl Ak
el S e T Cirm; Joinnimintatal)
FAM size ok IFFFFFF
Byte @b Litthe emilam
Filed contig
FLESE B AncHs] VhEE
Eraie ALl
Bata bk width 16 Eit
FlLash it soiblicess CrmdnSuiututuialal)
Target wHLEE CrminSaimtututntal)

Tarpet imspe Tile ORI TN TR M T i . i

Fileiame | whiddess. kin

FileSizer 3Ri1¥

iy eraee wtart

Erae amgletefis

e B0 T T
il d e i ey e
bl d b im gregram Chmglete 888

1Z oo i
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WRITING IMAGE FILES TO INTEL STRATA FLASH MEMORY WITH UART

1. Connect MULTI-ICE and execute “ 2440norom.ini “ file.

File

Gearch Processor Wiews System Wiewe Epscute  Ogfione

el | | ool Sl | Suitel | DBPEIWIRIE) | (0 EIBIEE RIS | ] BlEiel E o] 8l el

Tangt Ihq- | Flgs | Clasa |

Wingrw  Help

il AFMEHT_D

UL LCEE ]
HOIOIE
MILO3Ic
200
o liid ]
LTI
il
SDOIEDn

[ 5500 (e
[ et BEO2 D]
[ Cecudndil G20}
[ingeELL 00D}
[ lafEEELa)
[ e 5B AL
[ (g e BETLI TN D)
[ieLeiE e

ENTER SLE[ cuSFI07 4]

MG
LT
W OOIGAn
MILOI0aA
AN sk
S aa
MO
mbndihs
ApaEE
MOt
MOGI0:D
L]
DO

[ o5 RAIL B D)
[ 38 LL Bl
[ et E0IL D]
[ CecadafiL GLE]
[ieseBELL 00D}
[ lafEEEEa)
[ SFEL D]
[ o e ERLATNIE]
[ e diesi)
[ O SELAOD]
[ Cec SR04 )
[ (ng = REDQD () 0
[éealeLELe]

BANEOR ZL[ CesmSEel D]

0Gd i
L]
HLTI0AE
MEGIdE
DD
H0Ined
SOLOI0aE
S0 e
HOI0LD
po Ll ]
AdntE
L
HMLOILa0

[ e5E1AMID0]
[ietedetiesi}
[ Dbz mSELOHID)
[ (s 5 I R)
[ edeil $4E)
[ a2 02 04]
[ Cos m- 011 £ 4]
[iniedE LI 4]
[0s el 520 (K10 )
[Cb: 1mPEE iFE ]
[ s esindiL 40
[imee il ol
[Db: 1mPEE EEA)

Foe Halp. greess Fl

L0 I0LLd ¢ o= ) 0do

I, [=0,A0]

rl, ik 30

El.0l.#L

QeID0IEIED ¢ (EnEecFVON & SlE|
el DxIEIGELT ¢ = Flx43000I4
LERE N L]

po Eld

o, D=100L10 © = Flx430EI00I4

£l [w2,p0])

L1:C1, Pedai) )

£l, [=0,80])

rl, i1

£l.rl ¥l

QedpdEes  © (ENTEN_EBLEEF & Qul&j
rl, DxIEI0L1S ¢ = FixSSOEI00E0

e0 [k, AD)
E0E0, PEsdi D
o, [zl D)

ch, Dl DaDaL14 ;
ti, [0, 0]

Qe I0OIEIeE - [(EINTER _ELEEF & Oa34]
rl, [=l0O0GL1A ;o= FiSSEILOI0

o, [xh, B0)
EUGEL, e sdiuin
e0, [=L,PD)

e0 DIl ls ;
L1100 FAI0RE D
£, o, i34
£, [=d] 4
L3 [xl] -4
EZEND
w300 el
£l 00 1D
ElgELl fL
3000 06 B

= w4 0dc

= el L3

¢ (WASEUF _SLEER + [ecl

¢ (WAREUF_SLEER + [ID

Lammand Line Inlerface

iC 8 Lirsi itiard i

Py epbegty 03t BORED, B30 5 a0 £ ok 3 &40TR0 [ 0. LT
Pebipy FEUE e ———————

Takug com Filsnesa: 24Inacam. ini

Dby room Z00Y. &, wx Lepx drefc.

Dby D0
Ty Bcom
Isbuy »com
Feepisy oom
I=busy mEvom
[abug Fowas [vEctoe_catch

For 53014400

SDEAM liwcls 32, i-EEN
FCLE 100, 15HEs  UFLL 46HE:
HFAN refrceak: B (BEcPcle)
=il

in syprearion sould mac ke parssd or ewslesced dm the given sonceds

I=biyy eZ¥al (ScEallmitiog chdblod UK

An sxpreasian ceuld mat ba pacssd o svsloetsd iz tha given conbast

Dby pusc pac A1Tc_IVC

Inwalid edpiession

Ty srom swak prx RLF TR

Dby brom [Sisshls Becch-log remsc]

Peepisy ougrn SOogEd (D 0
fom < Clack sEEing =0
*rom [FIL Lok time awitizg macimom]
rruan fdcID | pdwfifccLE| =0 i dcanii|
rivm FOARIHOLR: FOLE=La 2562,
Fowat TOedc[OLOLY | (SCaT]s [ LOCRT& 001
»coa [FCLE FHY seccimg: I0L.Z5HEx -> [7E. 2

> T.Bus

«2]

PEusn Tndga OB | PR LE ) ] o S |+ £ D2 ]

>rom [ICLE PAT spibing: §Hr -5 3=27E,21,7]

wune PibeAcDORBGAE | DIwIBd 12 )+ O B d A+ Doc 3 1] |

*0om 47 MENOTF S&TLARQ 3%
mEvm [Baskd T JZ-BAE bus wldem)
mwns T 4A0000I0 [x220 00900

reom [Pamil-5r koceas oyclier ld-slocks, oreermif-clack]

= GH 0P | PR 1A e LL Y+ T+
e AMNE0AE | [0 13 b D LL ) 4 P ) 4
Il M0 e | D330 e D LL )] Ll 4
" AMEOLD | PRI LD T

r2Mar

Fruac
b

{0 |
DR )
JEHEE )
s |

i+ +

o DA | (DT |

Dl | (L E |+

+ind |+ S+
*

Ling 125, Cod O Bt -0E ARMET.0 Dddmasl axd
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2. Load the image file (2440TEST .axf) to execute.

Targai |imaga | Filas

File Seach Pacessor Wews Suetem Wews Coscune Optors Wndow  Hedp

el o] | @0 Sl | G | E@TEEEE | EnesEEael | el wele E 2] 2

Class |

=i ARVEIT_0

AHMNETETE L - Llgpssp=emb

S el EnET
SO0 0: [ CeendODEl ]
00010 [ Iwsed () DEL)
I 14 [ Ccamiffffn]
A 1A | Fwead 0007
00000 1 | Deoe ] 00 40
SO0RI0AIEH | Sucsmdd X1 EH1 B
00IE [PoleLDeell)
JO0O0E0ZA (| Secd 8 Dy 20
M0 E [ Eeode L Dep] ]
005 | SxEECELELE )
JCACO S, [ Ecflpef R
R R PR ] ]
MMM [ fxEffELfEfE])
M [Eiriefefi]
S04, | Deie e ) 0w 3
s FIOE | Cxa La D2 0G0
00080 [DweL000E])
3I0A0E150 | fxLedODOE ]
MK 5, [T FACODh ]
SO ES | S D)
3OO0 %= (| fecs lafil[6X)
H0de) [fwe=1lB40]
SI0ADNEA | Sxa A0LINO]
MI0AEA [ ExensnLDLD]
SOE: [BweZillina)
OO0 T [ Seclmf Ef B2 )
SIO000TE, [DweSAEDIRE]
000 TA | Sxe 02 IND]
AT [fxeisblb2ZD]
0N E) [ fwedSl00l)
JOOOMEES, [ CximfEfefd]
000 [IwesAL0man]
ICAMNE: | CecaADIDOL0Y
DEOKICNIRN [ Bwcs 1aDiE [xie
ENTER_ELE| fweddciin4)

Far Halg, prags Fl

Harsll=ESWL

HardlarFabact

Harrdl=eDabaEr

D SO [00014

Hared 1 TF)

Hared 12E¥I0)

EncacFRDE

m0EIdesll

O [ B0 e 320

(e E10eeDl

[ 44844444

(e S]] 21 H]

L] s 4 44

[d == ]+ 444

imefefeded ...

BesttHendles

-3 1]

ol 8B

ENTER_SLIEP

wl, I GE0E 10 7 o= Bl (e D2l
EY, [EQ00]

el x3

el rl il

=L, [c0,#0]

wl, Al 10

EL;f1;il

e MM00Es ; (InescifAIN 4 O2IZ4)
B, 03 0MLL4 ¢ o= diwdo e
=2, [e0,80]

£, Al 30

ELiLl#l

O SO0 ¢ (EntsciWIN + 0e38)
Bl 0EI0MLLY F o= Blwds0 i
1, [c0,.#0]

B, 14

BN, ALl ;o= Flwds (RS

Command Ling Intsriacs

DaPijg hSEal psd RLFT_AWVL

Irralid ssprarsion

Tpasg »0am BwwT paE SLF_EWCad

Ietug *cas [dizsble BPabch-Jog reart]

Tebug =mawt ShcSRIeEID O

Debijg pivim Of CLoZE SEULAiRg O

Twtug >cam [FLL lack tims switirsy mescimus]

Tetug »owar =idodid il | idwiffos b+ iimERtocif)
Dabug Foam FOLECHOILE:-FOLE=0:2:32.

Tebug =mnt SIdIinld | (EcZ]+ (1<l +dD] ]

Debijg »oam [FILE FH3 aerriseg: 101, Z5EHE - DTL.E,E]
Tabugy =rwwt Phedslil0ld | (SxT8Cl T4 [Tl )4 (Delcd] )
Petug »oom [ULE FRE seccimg) 33MHz - (T, 3,3]

[ebug Fownt TORSIGIONE | (SxIBCCLE) & (I d] 4 (Bx 30| )
Iwbug *cam << Memapy sscrimg >3

Debijg »oam [BEARE/TI JE-BAC Bud widch]

Iatug Srwwt TheABIGIEID Dl 230000

Peparg =oam [BRRRO-51 Aooeas apaler Id4-olodws, eslers) -olaok]

Dby Powmt TECABIOI0NE | (S0 LA )b [DOCEL & (Tl b D0 | DT b | B0 T
Tty >ewwt ShedlITd DR | (82 130+ OB |+ Vel i+ Dol i+ | A+ |2 3] =
Pebisg gt =Dad0IE | PR LI+ | O0ChL | T ok § D00l ok | oCd | B0 ) #
Iatug Srwwt TOcASIOIOLD | (SCC L0 | QDL b o T e o] D00 o DR e [ DL 2]
Peparg =t SldBd0I0Ld | D13+ EL I+ LTt b s i+ Rl + | e T+
Debiig hownt TOASIOIOLE | P800 L0 d |DOCRL | ToOB ok of Ol o | DD e | D0 T 8

I+bug >cas [AenkG/T: JDAAR, Tood: iclock, CR:P-ERdc]

Pebisg gt =IWEIMI0LE | (B LEj+ | 0ecii®l|

Iatug rewwt TOCASIOIOED | (3CC1E)+ Q2] +l]

Petag »oom [JIPRAN p2Cresh engble, Trpe&olk, Tre=§olk, Refreshi1684]
Debiig bowat TOxaBIOI02] | (EDCZT)d |DOC2T ) 4 (D020 & | Lo 1A b4 DRSS

DsTug »cas [SCFT_IH enshls, ICLK_TH smabls, Paxkoi] sescoy maps OO

Pebisg owar =Dl 02E (le | LoE i+ Bood] )
Datug *cas [BenkeT Ch: I-clackr]

Pty »owat sl nic w0

Deliig howat TOxaSIMI0I0 D=0

Istug =

L]

w

»

Ling |87, Cal 20 Mubi-CE SR S0T 0 2490w axd
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3. Execute 2440TEST code with Go command.

e Search Pacessor Wews  Syetemn Vews Cpecvte Opliors Mindow  Help

2] | | ¥l |§|5| | EleFEEsE | B remE == | Sl

Targai | imags | Flas | Class |
& ARMLNT_0

-_

AFTMTEHIT 0 - C:WYHLFPWSSC 2440 PN T - r ., . o I8 P | C i ]
Cammand Lire mefsce
hl-h'nq >muac par IFc_SWT
walid epressien
»oom sk par RIF_SECIZ
rEom [@ipakls Watch-Pag pepsc)
rEwal "3 I0NE]IGE] O
beopm 44 Cleck sstiizg 3
wiom [FLL Bok cims secring saiimom)
rawak TOwd4cOI0IO [ |EEEECCL ] 4 D3k BRI ]
weom FOLEiECLE: FCLE=Li 21 2,
rEAL "imSERIN LA [ b | LOCD e 0 |
cpm [FCLE FES mscting: LOL.ZSHEx -> dndf,2,12]
18 i1 wauar STeACOIO0D. [ (TEos 13 H DnEcodi+ il |
»zom [IKLE FES mattingz4BfiHr -» O=x71B8,.I,3]
rEuan w4000 [T 12 5| (el e el |
2o o EemOry SELLing o0
oo [Bamkf 7z JZ-hit bux widch]
/4 HBT imir. LB coche an, wauar SingdEO0N o200 i)
M Ina®dl = doom [Bapki-9: dccmrs cycle: lé—clacks, othaca:=d-zlock]
. . wEuan w4000, 0SS LI ]+ LR+ S E] = iG]+ (g A+ (I 3 4
AUF ADELD wERal O ASOIO00E | CL | o WO b | Do B e [T B o DD ok o DR
et lib dmit]]: Jvfpr A% 1.0 et "OeSE00000: | |OECLI]+ (DL LD+ | LR = L E ]+ (DL A (DL T
Serdit R LA NS ETR T Ced DS AR D A R GO | R Ceril
Sawak TAEOAILA [ {OCCL |4 ICCLEY b | DOCE] & [0 B | 4 (Dl A4 D2
i Clack sscting Faus imdRd0dla (|KclIj+{s i+ ekl R+ (D) +(Dcc Z i+
ChafigeC leckbivioee (B2, 1355 i 11Eid wEom |FankEsl: EHIRAN, TeislsZoledk, LAsd-bit)
Chsnpal? ] Wslos | 245, 11,017 J§ TN 2 rawat "LrAS0Adc (LS| + (DI LD
TR R L 1T Lt {528, L, L) BT rawan “UndE0IMS) [ {RalE|H(l|+L)
ChsnpeDPLl¥alus |de38,2,2 7 A STEME repm |[SOFAE remfcerh e=sble, Trpslelk, TeesSelk, Fefzesi=lES4]
Fpusr imdBI0dZd (| l<cdj+ (=< E 0+ (e i+ 1< LR ]+ 1E5A)
wEim |FFE_EN erAable; BCLE EN enable, Denke/V WLy Bapi sqfEsn
>uac "OmAS0000E5T (Dech4 184 D44 |

#F Hidden
#isfins NFLL_SEL (4]
diefine FOLE_#EL [#4]

M R

HEld Malniwaid]

wmrimed int apll wval:

Led Dspiay|ierl)§

A Clock caldulgtios anly Cop ddspley 1sSsEmstios
Cals Clockid] :

UFEATE_FEFBESH (Balk} )

& GFID pores init.

PaEr_Tsini]s

riol [BamiésT LI 3-olodka]
awak "In4E0NIc =30
Fruse #4000 ] (el

x

¥
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S3C2440A PROGRAMMING FLASH MEMORIES

4. Select" 6:Program Flash” on the DNW.

NOTE: If you want to download 2440TEST.bin without MULTI-ICE, then skip the 1, 2 & 3 steps above and download
2440TEST.bin using the DNW (See EXECUTE 2440TEST WITHOUT MULTI-ICE).
After downloading 2440TEST.bin with the DNW, then you can also see the figure below.

=+ DNW v0.504 [COMI1.115200bps] [USB:OK]
Serial Port USBE Port Configuration  Help
E
[FSTATUS3=8]
[SHDKZ2448 Board Test Program Uer B.8]
[Fclk:Hclk/Pclk]=[283.2:181.6:58.8]Hhz
[Uclk=48.8KHhz]
B:User Test 1:Manual Reqg Set 2:PCHCIA test 3:Stepping stone
L:nWAIT test L:Mand test 6:Program Flash 7:DHA test
8:Interrupt test 9:Cpu speed test A18:Power/Clk test 11:Lcd test
12:Camera test 13:5P1 Test 14:1IC Test 15:RTC Test
16:IrDA Test 17:3D test 18 :ADC test 19:-ADC TS test
208:Timer test 21:1I1IS5 test 22:lart Test 23:C1lkdiv Test
Select the function to test
[ HOR Flash HMemory Writer Uer 8.1 ]
The program buffer : B:3100080080 ™~ Bx<33ff0000
a : AM29LVEB0BB =1 b : 28F128J3A(16HB} =2
S5elect the type of a flash memory ? 5
5. Select the type of memory as 28F128J3A (INTEL STRATA flash) by typing ‘b’.
6. Select whether you download through UARTO or MULTI-ICE.
— Type 'y’ then you can download a target file through UART. See the figure below.
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] ), 502 0 0bp 5:0 =1l
Serial Port USB Port Configuration  Help
B:User Test 1:Manual Reg Set 2:PCHCIA test 3:Stepping stone e
L:nWAIT test L:Hand test 6:Program Flash 7:DMA test
g:Interrupt test 9:Cpu speed test 18:Power/Clk test 11:Lcd test
12:Camera test 13:5PI Test 14:TIC Test 15 :RTC Test
16:IrDA Test 17:8D test 18:ADC test 19:ADC TS test
28:Timer test 21:II5 test 22:Uart Test 23:Clkdiv Test
Select the function to test : 6
[ HOR Flash Hemory Writer Uer 8.1 ]
The program buffer :© Bx31080086888 ™~ O0x33ff0000
a I AMZ9LUBAOEE x1 b : 2BF128J3A(16HMB) x2
S5elect the type of a flash memory ?
Do you want to download through UARTA from B8x3186888688%7 [u/n]
downloadAddress = 3186800884
Download the plain binary file{.BHC) to be written
The file format : <n+6>{4)+{n)+C5{2)
To transmit .BIH file : wkocm? xxx.BIH /1 fd:1
Download methods : COM:BBit,HP,1STOP
STATUS : ==
W
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S3C2440A PROGRAMMING FLASH MEMORIES

7. Download a target file with the DNW by selecting Transmit menu from Serial Port.
— Serial Port 2> Transmit

 DNW viL50A  [COMI. 1 15200bps] (USE:OK]

B AR | 2080058 _Mon

g O] S [1s2440man, bin [ =
D o aTe [BIM Files ¢=bini=_nbl 3

— Select and Download a target file.

DHW w508 [COMI 1 EADbps] [USE D]
Zorial Ponn USE Por Conligura®on  Help
downloadAddress = 31880000 *
fhounload the plaim binary File(.DHC) to be witten
The File Fornat = <n+63{B)s(n)+05{2)

To transmit .BIMH file : wkocmd xxx BIH /1 Ad:
loownload methods ; COM:BBLL,HP ASTOP

ETATU: @ HHEEEESUUUUHEEEERUUUUHEREERRRHHHHEES
fbounload O.K.

[ 2BF128J30 Flash Writing Program |

LLL UEi"y ]"li’til’lt Hotes wwE
1. 2BF128J30 must be located at GxOE000BBE.
JA21-2, J2:3-3, JAc2-3, Je1-2
2. AFter programming, PHF1Z8J3A may be located at Bxd.
Hiz-3, J2:1-2, J3:1-2, JN:2-3

[ 2BFi28J3h Writing Program |
Source size [8:7] @ @h™BaSuh
favailable Target OFFset Address [@x7] @

@h 200000, b8dddn, ..., Tcedbibn
Input target address ofFfset [Bx?] :
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8. Write input target-offset address.

"MW w0500 ICOMI .1 152000 ps] [USE:OK]

Peunlerd ther plain Binary Filel.BEC) Do b writbes
Tt FEL® Format @ Caedd(k)=(mi=Ci(F)

Te traacwit .EBIH File : skerw? swx BIH 71 Fazd
et el wrtieeic @ Db :EEEL HE,1ST

Llelwi @ FERFFEFFERFEEREEEREEREFERFFERFEERFERE
Peaainiaad B_K.

[ HEF1EFIS Flash Mritieg Progran |

e By Iaplrtaat Hebes ees
1. FEFIFREES ment B DeCated At OeoE000006.
-2, Jrir-¥, Eyrr-¥, Meri-:
(2. BFter progrianiey, JSF1XEEE ndy b Lecated ot O=0.
Jx-3, K-, E¥ri-2, Mard-¥

[ B4Fi3E558 Mriting Frogran |
Gewrce slze [Mxf] @ IFFafia

pvailable Target BFFet Sdlress [Ox?] 2

O, F 0000, S, ., 1CE0nns

Ingat target aSSrdis offFet [QxF] @

Hgwrce Band eSSretl 0¥ QID0ON) = DeFTOOO00
Target Bake a8Scess)M=OFOOO000) - DeEODO000
Target sffset {u=n) - n=

Target size (ReFOnines) = Defafh

Fakd ek SeLber @ DeEOOOOO0.
Il SOOOOOND Erahe B.E.

(Start oF thi data writiey. ..
Enell &F thet data writiog

prarifylny Start. ..
ard Py Enel®ff

brwcer Test 1:Habmal By Iat FrhbHEla test Frlitepping choms
raalalT test SrHamed bt drFregran Flach Trbela tast

§ laterrept tect  Polps S bett  TlcPessrCLE best 41 iLod best

1 :bamira Dkt 1E25F1 Test 1l 10E Test 15RTE Test

162 Irid Tost 1701 Tast 1625 bt 1hoadd test
Fialt T tect T bt Frlls best Fr:Elnais Test

[falict it Feleilieos Te tost @

9. Turn the SMDK2440 off and again on.
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PROGRAMMING FLASH MEMORIES

WRITING IMAGE FILES TO INTEL STRATA FLASH MEMORY WITH MULTI-ICE

1. Connect MULTI-ICE and execute “ norom.ini “ file.

& AAM Debugger - NO IMAGE

File Edit Search Wiew Cs Execute Options Window Help

B DRl 2 v <] E{EAE] ¥ ] @) ARME|E BRI )] BlaE|

¢ ARM - Execution Window =] Command Windaw

Ix00000490 Hl 03520 ARfM=d Command Interface

k00000454 bl Ixldc Debug: ob d:%2410Morom. ind

0=00000438 || nov  z0,#0 >[* 53C2410

0x0000049c | bl (%864 »|% SDRAN Little 32

000000420 | now r0, 40 »|# 64UB

0=000004a4 bl lzc08 i

000000428 | add vl pe, 402200 : #0xbbD »let $vector_catch = D=00

Ix000004ac Hl Nxdcd »let, Ssem&hostlng_enahled = (=00

0=000004b0 | mov  xl,#0x32 let psr=AlFt_SVC

0z000004b4 | add r0,pc, #2220 ; #0x6de »|let psr=AIF_SVC32

0=000004b8 bl lzded P

0000004k | ldr v2, 0200000718 : = $0x33¢£6f00  |2|disable wit

0x000004c0 | now r1, #0x30000000 »|let 0=53000000=0

0z000004c4 add v, pc, #0x250 ; #0=71c §| st

0=000004c8 bl lzded pllse

0x000004cc | ldr r2, 000000738 - = #0x33e£000n  Plet Oxdc00004={{0x70cc12)+{0xdccd)+0x2) m

Dx000004d0 nov 1, #0230000000 »let 0xdc000008=((0=58¢<12)+(0nd<cd)+0d)

0z000004d4 add v, po, #0x260 ; #0x73c ilmemset

0=000004d8 bl lzded

0x000004ds | now rd, $0z30000000 rlet 0z48000000=0222000000

Ix000004&D adds r17 rd #l=cdl00000 slet 0xdB000004=( (013 +{ 01+ (7cB)+{ Do) +( 04+ (042 )40)

Ix00004ed suhcsz r1? r1? #0x££0000 »let 0xd8000008=( (013 +{ 01 +(7ceB)+{Dccn)+(0¢cd )+ (D¢ )+0)

Ix00004e8 hes gxshg ' »let 0xdB00000c=( (013 + {0 )+(7cB)+{Dccn)+(0¢cd )+ (02 )+0)

Ix000004e0 b Ixdf8 vlet 0xdB000010=((0¢c1d)+{ 0L +(TcB)+{0ccn)+(0¢cd )+ (02 )+0)

k0000040 add vl vd #0x100 »let 0xd8000014=((0¢<1)+ {01+ ( 7B+ 0cco)+(0¢c 41+ ( 042 )40)

x000004£4 b gxaeg' vlet 0xd8000018=((0¢cl3)+(0ccI (7B )+ 0¢4RI+(04¢d)+(0¢c2)+0)

xl000048 str rd, [rd,#0] »let 0xdB00001z=((3¢<158)+{0¢¢2)+1)

Ixl00004fe b lxdf0 vlet 0xdB000020=((3<<15)+(0<¢2)+1)

Nx00000500 add vl po, #05250 © #0x758 slet 0xdB000024=( (12 +{ 022 +( 0200+ (1¢<18)4(2¢<16)+1113)

000000504 bl ladcd ' slet 0x48000028=0%32

0=00000508 | mov x4, #0x30000000 let 024300002c+0=20

0x0000050c | adds 12, d,#0xcd000000 Debug: | =

4 | )

| CProgram Fllest ARMAMU-CEMURHCE dl localhost: TAP 0, ARM3ZT ]_W v
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2. Load the image file (2440TEST.axf) to execute.

Fle Search PBaacessor Wews Susiem Vews Coscute Oplions  Mrdow  Help

Targai | imags | Flas | Class |

e & P Gl | S | Be©wmEE) | 6o e

i ARV 0

ZLELErel] |DxCECCECEL ) ELCEELEE unSefined

AFMIZIT 0 - Dinan=nmbly Cammanid Lina

Camim and Ling mharkice

SESEEred [DxfCfecfefe]) =] =4=4+ 444 mndsfined
SEfCfed [ImCCCCLCLl) MELELELLE J 7 undtliasd
ZIELEfec [OxEEEEPELE) DeEfELELES e fined
SEELEEED [weffefote) 4 EEELETET 1 7 ondelinad
ZEEFEFES [BwCEEEELLE ) | IRELELETEE unSefined
SESEEEEA [Dxfffefefe) [={=4=4 44 4 ndsfined

L idadadadd L] 4 4o T adelind

[ S=a I EI0TE ) FaratHendlac

[Bce i (X1 D2 ) Hared 1 rivade s

[ CecealImINE] Harsl 12 ESW]

[ Bzca w1 [R1[H1E ) Enta o FEDE
[EwdE Ll ) aiEI0e=ll
[ S0 DA O 2930 ) = (6] B0 e 320
[Encd e L Des el ) ] e f A0 el
ISLELLICIL ) | IELCILTLE
[ExEsEfEEefE] a4 H]
Lo idadadedd Lol dmd ad 54
IE=<EEEEFELE] =EEEEESES
it adadndd -1 i fefefed .-,
| SeegULILSE BEsECHERELEE
Ezey e FULE | Dzca L2 (910 ) . [ 1]
00047 [lwedLi00E) o, fe
MO | CxclodEEE ) ENTER_SLEET
PI0A0A5 [ Ducs SR Iyl o, 0wIOB0 DT ; & EleARIDZd
SRS | GeedArramD) ¥, [E0 0]
MOI00% [fxcalabLOX]) ' el,z3
S0IE] [lweE1LE4D) EL 21, #0400
SI0A0EA | Secn SADLINLG] el, [E0,. 0]
FIOA0 A [ EwceAaDLDLD sk, B30
SOa(Es [ PwedSIL0l) el o1l

schey C: Y HTRAE: 24400 2446 eorom) 24 ncras. ind
FIOE

oo 3

room 3003, §. @x lac dradt,

TETER

rom  Far ERC2440%

riom  EDRAH_Liccle 53, &d48R

*rom FCLE-LOL.ZIMH:  OFLL: 4BMHx

room  SORAR refmephs Gdma{Eryule] - 7.0
mawal §veiboc _cabch LiE Lo

|/ Caca W (X105 HarsdlacPabact pxprearian coold zot be parssd or svaluscsd in s given comTewt
[ Bwe a0 05T Barrd1=EDsbaET ey Pauet faemihiaring_suabled  QEOD

|CwamEEEELn ] e =IO 0034 m<prensian coold =ot by parzsd or svalusted in tEa given co=taxt

[ Buce w1 D0 ) Harel1=p T ey FEueT par WIFT ST
| sl (O i § Harsl12eFE0 Lmvalid expreision

¥rum suac pac AIF_IWVCIE

Pi0E [Alzable Wartoh-Dog Desen]

rywat TlxiNIDOI0D O

oo ¢ Cleck penoimeg #>

idm [FLL 10fE Tl Seliisg wasiwim|

Frwnt "OwAcOiOInd o |defedCclE|+ (DmEEEdl] )

»iom FCLKIBCLE BCLE=LEENE,

rownt TledcODOILE o |Q0a2fe Lol | 4007 ]

pom [FCLF FRES meccing: iGL.35HHz —= &x7¢ .2, %)
EEAT "UndLODOT08 § |t el L2 b | LS008 b | e 200l |
rrom [LELE FES sscting:48lHc -> DxXTH.Z, 3]

e2ueT SUwdo0DOIE | EE TR L2+ Ol el |
>rom «f Pesary makting 33

oo [RarkiesT: Ji-hit besm widich]

EERT "Us4EODOT] el SOLERIIE]

o [BarkD-%: kccears cycle: Lld-clocks, athszazid-clack]

d-U T e T T T P B TR I e A MR R Rt TR W T g o RE S R R e ]
Fount TOmABODOI0E [ DL b DL 1] & [T | [ D b o DRl D02 ) ]
puns WwdRILOI0: ([0S0 IDEc L] | = TedB|+ (IR |+ (I dh+ {02 +0]
T TR T T A L B R R Sl RN e Bed TR e B St EER S B ]

¥

Far Helg, prags F|

(i Pord PAUN-ICE SRMBCTT D 2840wt awl
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3. Select Load Memory From File... on the file menu of AXD.

Loamd mge...

Lomd Debug Svmbals
Al cead et Image
Dnen Fik

Sass Mamane To Fla...
Flawsh Downlead...
Leieed Be-agion

Bama Besasion

Aeszeni Fles
Aesent Imagas
Az enl Sumbrls
Aesent Sassions

L s 'Zirank b e
Iripeaiil Foern ads

Esht

Fils Saerch Procdsdor Wews  Byaswam Wews Egacik Opfions

Wirelow  Halp

] Gl | EmmE mEE | e DR EE | ] BEe] 5T e | e

sl
haq

dr
i

ey
i1
i

drk

AW (s 5E100L0]
AEICIEAE [dxa:LIA0E1]
AMDIdD [olafcrto]
I GIEI0 [dxaZd1d024]
AMDIDSE [Mwelabfine]
AEIEIESE [dxa3S0E0E0I]
AMDIDSD [l 1Al ie]
I Gk 0 [xaZ3EL T24]
AMDIE [Mee5a100L0]
JEGIESE [dxa3LIN001]
AMDIESD [Holatetrto]
I EETD [T =410024]
ML [fmelabfiie]
Unrt_EBatH[ draZ3e02I74]
AMDIET 0 [es a0 0]
IO CEIEA D [ e 35 6] R0 0]
AMDIEA [l e id]
JE]GTEAE [dxaXabl450]
AMDIEA0 [essE10L0]
AL 0 [deaZl[E0E11]
AMDIEAd [(rl5d10024]

1]

Lt
LIL
by
Ldrh
[ Lol
=]

| Lo
Ldr
Ldt
LIL
by
Ldrhk
R
Ldr
Lt
=np
b
s
Ldx

LACTeED

=14

:MIOChOa  : |Usce TxEmpiy + Do) %
e7a114 -
o], I 100 aed ; = PlxISE3Ld

0, [0, 40]

=]

FIEE 0 (Tarc_ecdh + &)

L, [Pk 50 D8] (=1 £]
el el B 1]

o, fl

FIoEEd 0 (Tarc_fecdh + Dildd
i, [cl , FDe:24]

pel.11d

i, fl

FI0EE 0 (Tarc_fecdh + (@)
cl, 0w I0IHIAEE : = JfixSOO0AE0

i [EL A 10]

i, Pl

obad 0 (Tacc_ecah + On3dd
i, [l Fie:Z4]

P7a14

=

la.r1d

el ixAEEdEc ; = FdxSOEICEA 0

B, [EL A i10]

i, h1

i ilaed 3 (Taen_ferah + (ki
i, [, Brecz4]

1114

o, In I EaEd ; = FxIESEILd
N, [ ,80)

o, h0

DS (Uact_fecEey + (oid)

£:L. . Ce: 54 O] D] O]
e, [l B 1]
il zO, FL

B [EL R0 4]

LK

Coamimared Lirea brkifacs

T

awarn paE WIFT_SW

Inwvelid mxprearion

1E301T]
Tabup

IR TRAn paE SIF_BWISIE

dzpa [dirsble Bakch-Tag carak]

rawar w5 EEmD o

2ol %0 Clesck makting

wiol [FLL Iook Time s&cTing Waciwim]

soenk TwAcflRIOAD | Doc BB Bal 2] 4 Do EE BT |

>l FOLEITHCLER FCLE=11 &1 2,

rawent "OnAclEIOLE | D24 | Lol ]+ 00] )

ol [FCLE FM3 gevcioen LOL.I5MHZ = (MTL,2.3]
daenk "OndclEI0NE | O TECL 12 34 | OQn2fa ] 4 e I 0 |
a0l [UCLE P gevcivegn 4B8HHz - (7,2,3]

axweat "OnAclIO0E | Do TOC 12 1 | QuZd ] - [ e 2017 |
0l 0 BERIEY ARTEATEy Mo

rcocm [BankE,ST: IZ-bBik bux widih]

rmar S a0 () ) (g 2 0] (e )
acpm [BankD-%: Accesr cycle:
4R ) (04
ik E4] ] CE1 B
w4 Ea) (o) (o)
Tia 4B NIOLD
rawar “iwdBinolg
raweat "OnABIEI0LE
ol [BAEEST! APBAN, Trodsdoledk, Chi®-Dic]
aaweak TOpdNIONOLe | 3=l |4 DCe2 4]

awar Owd Bl aD | ol Bi+iiaRivl]

A

raeni
TEAE,
MR

Ld-clechs, citmcazl-clack]

[ KT R A W R Tt RE D TR e R |
| CRGaTL B | b DAL L | e, T ) e | B B | o D) o
| €l 3+ L L]+ Tl o o |+ D |
(Rt TR il RN EY &t KN B T e |
| el 3+ Dt L1+ Tl o o |+ Dl 4
| DR L B | b DAL L [ e, T ) e | DA B | o DR o |

rcpm [ TFAR cafcesh snsbhla, TrpeIclk, Tro=3<lk, Fafosah:l
el L LA R T el B T B e B A Do A RN D I R AN e HA R AN 2T I}
depm [TCFE EH snshla, T=CLE EH snshla, Esrki)/T sasacy ssps

sl Swd B 0dE el 1ok i) Lesd) )
rcpa [BmnkE/T Clz I-cle<hkal]

rAwar B 0do Do)

dawnk TrABIEIOID [ 250

o

Laed data ®am diak# mamany Ling 123, Cod D WUEHCE ARMASETT.D | 4 Db, gl
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— Get the target file to 0x31000000 in SMDK?2440 Board.
Load Memory From File

= AR [ 240058 Mon ~| & &t B

=R E= bR {u2440rman, bin 220

OHe ATy | &l Files (= =) -] | 4

Address: |EI:-:31 Q0oooo

Frocessors

,L
ELECTRONICS
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4. Execute 2440TEST.axf file with GO command.

Fle Seach Pacsssor Wews Suctem Wews Coecune Optoes Mndow  Hedp

) ) o) vl || Gl || ElOITEIEISE) |6 D@ 2l | e slelelo £ sl 8] e

Targal |image | Filas | Class |

=i ARVEIT_0

33040614
330KI00 1
AR E1)
330004

= 330 0hzA
S0 0b 22
33061 0b 260
R0 0h 3
330K 0029
A00h 5
3300063
S30R100 4
R0 0b S
3I0h A
A30El0h ]
S0 0hEY
53061 0b =
AR E
330KI0LED
Al 0hi
S0 0BEA
330K Db B
AR 0hT)
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PROGRAMMING FLASH MEMORIES S3C2440A

5. Select " 6:Program Flash " on the DNW.

NOTE: If you want to download 2440TEST.bin without MULTI-ICE, then skip the 1, 2 & 3 steps above and download
2440TEST.bin using the DNW (See EXECUTE 2440TEST WITHOUT MULTI-ICE).
After downloading 2440TEST.bin with the DNW, then you can also see the figure below.

- DNW v0.504 [COM1,115200bps] [USB:OK] =13
Serial Port USE Port Configuration Help
[FSTATUS3=8] ~

[EHDK2448 Board Test Program Uer B.8]

[Fclk:Hclk/Pclk]=[203.2:181.6:58.8]Hhz
[Uclk=48.8Hhz]

B:User Test 1:Manual Reg Set 2:PCHCIA test 3:Stepping stone

4:nWAIT test 5:Hand test 6:Program Flash 7:DMA test
8:Interrupt test 9:Cpu speed test A8:Power/Clk test A1:Lcd test
12:Camera test 13:5PI Test 14:11C Test 15:RTC Test
16:IrDA Test 17 :UART Test 18:3D test 192:ADC test
Z2B:ADC TS test 21:Timer test 22:115 test 23:C1lkdiv Test

Select the Function to test

[ HOR Flash Memory Writer Uer 8.1 ]

a : AMZ9LUBBOEB =1 : 2BF12BJ3A(16MB) =2
Select the type of a flash memory % b
Do you want to download through UARTH from 8x3188088087 [yfn] = n

The program buffer : ﬂﬁfiﬁﬂﬂﬂﬂﬂ ™~ B8x33fraeea

6. Select the type of memory as 28F128J3A (INTEL STRATA flash) by typing ‘b’.
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7. Select whether you download through UARTO or MULTI-ICE.

— Type ‘n’ then you can see the figure below in the DNW.

ool DNW v0.50A [COMI.115200bps] [USE: OK]
Serfal Port USB Port Configuration  Help

B:User Test 1:Hanual Reg Set 2:PCHCIA test 3:5tepping stone

L:nWAIT test L :Hand test 6:Program Flash f:DHMA test

8:Interrupt test 9:Cpu speed test 18:Power/Clk test 11:Lcd test
12:Camera test 13 :5PI Test 14:11IC Test 15:RTC Test
16:IrDA Test 17 :UART Test 18:3D test 19:ADC test
28:ADC TS test 21:Timer test 22:115 test 23:C1kdiv Test

Select the function to test : 6

[ HOR Flash Hemory Writer Uer 8.1 ]

The program buffer :© 6x310008808 ™~ Ox33Ff8000

4 : AMZ9LUBBEBE =1 b : 28F128J3A(16HB) x2

S5elect the type of a flash memory % b

Do you want to download through UARTA from B8x23180008867 [y/n] - n

[ 2BF12843A Flash Writing Program ]
*x% Uery Important Hotes xx
1. 2BF128J3A must be located at BxB8000080.
J1:1-2, J2:2-3, J3:2-3, Ju:1-2
2. After programming, 28F128J3A may be located at 8x8.
J1:2-3, J2:21-2, J3:1-2, J4:2-3
The data must be downloaded using ICE or USE from 8x31880864
[ 28F12843n UWriting Program ]
Source size [Bx?] = Bh™Bh
Available Target 0Offset Address [Bx?] :

6h,28088h, 4808880, ..., 1ced@doh
Input target address offset [Bx?] :

8. Write input target address offset and size of the target file in hexadecimal.
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(Dn L B0 ICOMI L1 I 530bas] [USE:0K]

The program buFfFer ; EediElgadd ™ Ock3FF ARRH
5 AMZYLUBABEE =1 b ZREFIZRARS(16ME) x2
lect the Eppe oF & Flash peporg 7 &
you wank En desmlgad Through DBEETN from BEITREQENET [gin] = n

[ SEF1ZBJAR Flash weiting Progran |
#sa Upry Inpbrtant Hotos sss

1. Z9F128J30 must B located akt Ow0EDDDDOD.

-2, JE2rE-R, HEEE-3, Jaii-2
[E. A¥ter programmisg. 2FIZEJ3A nep Be located ab =0,
J:2-3, J2E1-2, EEE-2, JhGE-3
Ihe dala pust be sssmloaded using 100 er USH Fron G=31000DBE
[ 28F128J30 Writisy Pragram |

Saurce slze [@xT] 1 DR™Bh

lahle Target BFFset Address=s [Be?] :
R T BENSh  AERA0h, ..., Tced@9@h
Ingut target address offse :
Input target siee [7]
gurce hase address | i bses = Ux¥10npaEs
larget bhase address(iiEbbiddd) - cE00DDDE
Tarqet offset i = xi
Target size [ obdben] = OwiODBn

rase the secbor ; MeADRbEeE,
lock_Bo@aq9e Erave 0.H.

tart of the dabs sweiting...
(1)
md af the data weiting
1fylng Start...
1fying Endd%d

nzliser Tesk 1:Manual Reg Set ZoPCMCIA Eest Joitepping shose
EENMIT EPsE S:Mand Ersk &zProgram Flash T:0MR Eesk
®:Interrupk EBest F:Cpu =peed bEext  AB:Power/Clk bext  19:Lcd Eesk
1F:Camera Ersk T3:5F1 Tesk TH:zTIE Tesk 15:ATE Tesk

14z Ird0A TesE THZUAHRT TesE 18250 Tesk 19ADE EpsE

NZADE TS Eesl FiTimer Tesl I2ENIE Legl 2ACLKdiY_Test

#lgct the FuncCise tae test :

9. Turn the SMDK2440 off and again on.
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WRITING IMAGE FILES TO INTEL STRATA FLASH MEMORY WITH OPENICE32-A900

OPENice32-A900 can write image to Intel Strata Flash memory as Multi-ICE. However, OPENice32-A900 provide
a Flash Write Program that is easy to use and don'’t require ARM SDT/ADS debugger nor DNW.

Connect OPENice32-A900 to PC through USB and to SMDK2440 board with 20pin Cable.

Set the Jumper J1, J2, J3 and J4 as followings and switch on the board
J1-B: 2-3 (short) J2-B: 1-2 (short) J3-B: 1-2 (short) J4-B: 2-3 (short)

3. Run the Flash Write program and select Connect MDS from the File menu.

[Flash LF 1 |
Eile LUtlny Frash Help

= | & [ 28

y .

II::l1nl|:|

4. Select SMU Manger from the utility menu and choose a device file, SMDK2440. It is used to initialize the
system registers in case of there is no boot ROM. If you can't find the file, download the device file SMDK2410
instead of SMDK?2440. After that, edit each value if necessary.

U manager ﬁ|

Device |ShOKZ440 = | Add dz-.n-:..-'|
= "Et-;ug-r':'l:p'n"nrﬁ:'u' S T T o R

1 WTDON S0 00000000 94 R

"3 FTRZE 48000008 FFFFFFFF 4 Falwe

| FTSUEMEF 480000 0000FFF 4 B

q LOCKTIME 4COD0DDD DOFFFFFF 4 P

5 WFLLCORN ACO0000  nonsCnaE 4 i

£ EveSiCed SO00000 22111120 4 Fatvd

¥ B&MECOMO 0000 00000700 4 P

] BAMKDOMNT SE00000E 00000700 4 Fiftd

d BLAMRECOME SN0C oot 4 Five

10 BAMECOMA G000 00000700 4 B

11 BAMKDOMNA S04 00000700 L] R

12 BAMKOOMS SEOnE 0o 4 i

13 BAMKCOMG SO0 0001 8005 4 R

14 BAMEDOMT S0NED 000 005 4 Pw

1= cEmESIH AT A mMmMaEmacs A [T, T F] L

Seve Close
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PROGRAMMING FLASH MEMORIES S3C2440A
5. Select Config.. from the Flash menu and Set the write options as followings
Config target E|
Device : [SMDK2440 | ¥ SetsMmu
Ak information (Hex) Endian
Base Addr|3[l[l|]|:||:||:||:l Size ]DBFFFFFF " Big * Little
File 1 ] File?2 |File3 | File 4Length(4byte)+File+CheckSum) |
Flash device |INTEL_28F128J3A vl
Diata width Erase Flash address(Hex)-
" Bhit & Chip Base (00000000
£ 16hit " Sectar Target |IIIIIIIIIIIIIIIIZIIZIIZI
& 32bit © None Erase size]
TargetImage File:
|C:RWDF{KHEMIZIREMEIUSEE_MDnHuEdl4I]m|:|n.bin _J
8] 4 Cancel |
— Device: SMDK2440
— Set SMU: Checked
— RAM Information: Base Address:30000000 Size: 3FFFFFF
— Endian: Little
— File 1 page
Download: checked
Flash Device Name: INTEL_28F128J3A
Erase:Chip
Data Bus width: 32bit
Flash Address: Base Address: 0 Target Address:0
— Target Image File: u2440mon.bin
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6. Click OK. Then the current configuration is displayed in the window.

e L&l Flash Aol

W 5 W A< tl

(R R R A e s R R P P R R R R T IS R R R R T I S R R ]

# Current canfig L]
EEAAA AR EE A R R R R EE AR R R

Pevice | EHDEE LS
BAN hase sddvess BRI
BN mixe = IuAFFFrer
Brie EEx = Litile smdian
Filel cemCig ...
Flagh i | INTEL_ 268F12ETIA
Eraes 1 KLN
Daks bus widih : XF Kt
Flark bame addcess @ DelSaaoono
Tapgel addross | Osigaaounn

Target dmage Tile | CoOVWOREYLZARINTAA0UER e ddimmes . Win

DN i il
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7. Select Write from the Flash Menu. Then it starts to erase the specified area of Intel Strata Flash and write the
image to the Flash memory. It takes about 10 second.

fila Lkiky Flash #Abod,

T a A

8 dEEEEE EELEEE R
¥ furrenl config L]
EEEEEbbbbddddd e EEEEERERbhd Al s R R
Bevice | SHOER24E0
BN hase aililiess I W INO000n0nn
BN aize ¢ WNIFFFFFF
Byts meu : Likkle mnddss
Filel config ...
Flaxh namm : INTEL_ FEFITEIIA
Eramp ¢ A1l
Dala bus widlh ¢ 32 Bik
Flash bage afdcctds | OH0DDDDINE
Tawgel alipeis [ERTETTTTE
Targel image fils IC R LA, A 0UEE M omyadd d il liin

Filelanes : ulddimes . bin

Filafize: 3I5417F

Thip sraze ksrk __.

Eraze compleoEsiil

adddlon. bin devnleading ..
WA bin pregraemiieg .
rﬂll:-un.l-in prbgram Ccomplete (90

Cannict
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SYSTEM DESIGN

OVERVIEW

The S3C2440A, SAMSUMG's 16/32-bit RISC microcontroller is cost-effective and high performance
microcontroller solution for hand-held devices and general applications. The S3C2440A has the following
integrated on-chip functions:

1.2V int., 2.5V/3.3V memory, 3.3V external I/O microprocessor with 16KB I-Cache/16KB D-Cache/MMU
External memory controller (SDRAM control and Chip select logic)

LCD controller (up to 4K color STN and 256K color TFT) with 1-ch LCD-dedicated DMA
4-ch DMAs with external request pins

3-ch UART (with IrDAL1.0, 64-Byte Tx FIFO, and 64-Byte Rx FIFO) / 2-ch SPI

1-ch multi-master [IC-BUS/1-ch 11S-BUS controller

AC97 Audio CODEC Interface

SD Host interface version 1.0 & Multi-Media Card Protocol version 2.11 compatible
2-port USB host /1-port USB device (ver 1.1)

4-ch PWM timers & 1-ch internal timer

Watch Dog Timer

130 general purpose I/O ports / 58 interrupt sources

Power control: Normal, Slow, Idle and Power-off mode

8-ch 10-bit ADC and Touch screen interface

RTC with calendar function

On-chip clock generator with PLL
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APPLICABLE SYSTEM WITH S3C2440A

The S3C2440A, SAMSUMG's 16/32-bit RISC microcontroller offers various functions and high efficiencies. In
addition to the high performance, the S3C2440A offers low current consumption, ensuring low costs.
The followings are sample applications that can be designed with the S3C2440A:

« GPS
e Personal Data Assistance (PDA)
e Fish Finder

¢ Portable Game Machine

¢ Fingerprint Identification System

e Car Navigation System

e Smart Phone

¢ Mobile Information Terminal (MIT)
* Web Screen Phone

e Web Pad
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MEMORY INTERFACE DESIGN
BOOT ROM DESIGN

After the system reset, the S3C2440A accesses 0x00000000 address, configuring some system variables.
Therefore, this special code (boot ROM image) should be located on the address 0x00000000. Bus width of boot
ROM can be selected by setting OM[1:0] pins.

Table 4-1. Data Bus Width for ROM Bank 0

OM[1:0] Data Bus Width
00 NAND boot
01 16-bit (half-word)
10 32-bit (word)
11 Test mode

NAND BOOT DESIGN

Figure 4-1 shows a design with NAND boot.

S3C2440X NAND Flash

DATA[7:0] |- | MD[7:0]

OM[O] R/NB |- nBUSY
oM[1] nFWE » NWE
NnFRE »| NRD
ALE »| ALE
L nFCE »| NCE
CLE > CLE

Figure 4-1. NAND Boot Design

MAKING NAND BOOT IMAGE

When making a NAND boot loader image, you can use the binary file that is made from compiling and linking.
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HALFWORD BOOT ROM DESIGN WITH BYTE EEPROM/FLASH
Figure 4-2 shows a design with half-word boot ROM with byte EEPROM/Flash.
@ S3C2440X EEPROM/
Flash
OMI[0] ADDR[24:1] | ADDR[21:0]
DATA[15:0] |« :
OM[1] [15:0] - DATAL O] DATA[7:0]
nGCSO0 » nCE
L nOE »| nOE
NWBE[1:0] » nWE
NWBE[0]
EEPROM/
Flash
» ADDR[21:0]
p| DATA[7:0]
DATA[15:8]
»| nCE
» nOE
» NWE
NWBE[1]
Figure 4-2. Half-word Boot ROM Design with Byte EEPROM/Flash
MAKING HALFWORD ROM IMAGE WITH BYTE EEPROM/FLASH
When make half-word ROM image, you can split two image files, EVEN and ODD.
Table 4-2. Relationship ROM Image and Endian
Big Endian Little Endian
DATA[7:0] Odd Even
DATA[15:8] Even Odd
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HALFWORD BOOT ROM DESIGN WITH HALFWORD EEPROM/FLASH

Figure 4-3 shows a design with half-word boot ROM with byte EEPROM/Flash.

O S3C2440X
oMo} ADDR[24:1]
OM[1] DATA[15:0]
nGCS0
4 nOE
nWE

A 4

v

DATA[15:0]

\ 4

A\ 4

EEPROM/
Flash

A[21:0]
DQ[15:0]

nCE
nOE
nWE

Figure 4-3. The Halfword Boot ROM Design with Halfword EEPROM/Flash
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S3C2440A

WORD BOOT ROM DESIGN WITH BYTE EEPROM/FLASH

Figure 4-4 shows a design with word boot ROM with byte EEPROM/Flash.

vy

DATA[7:0]

Q S3C2440X

OM[1]

ADDR[24:2]
OM[0]

DATA[31:0]

nGCS0
_ nOE
nWBE[3:0]

YVY

nWBE[0]

EEPROM/
Flash

A[21:0]
DQI7:0]

nCE
nOE

nWE

DATA[15:8]

vy

YVYY

NWBE[1]

EEPROM/
Flash

A[21:0]
DQI7:0]

nCE
nOE
nWE

DATA[23:16]

vy

nNWBE[2]

YVYYy

EEPROM/
Flash

A[21:0]
DQ[7:0]

nCE
nOE
nWE

vy

DATA[31:24]

YVvVYy

NWBEI[3]

EEPROM/
Flash

A[21:0]
DQI7:0]

nCE
nOE
nWE

Figure 4-4. The Word Boot ROM Design with Byte EEPROM/Flash
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MAKING WORD ROM IMAGE WITH BYTE EEPROM/FLASH

When you make a word ROM image, you can split it into four image files.

Preliminary product information describes products that are in development,
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Addr. ROM Image

0 A 4— size: byte Big Endian Little Endian
1 B DATA[31:24] A E ... D, H,...

2 C DATA[23:16] B, F,... C, G,...

3 D DATA[15:8] C, G,... B, F,...

4 E DATA[7:0] D, H,... A E ...

5 F

6 G

7 H

8 I

9 J

10 K

Figure 4-5. Relationship of ROM Image and Endian
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MEMORY BANK DESIGN AND CONTROL

The S3C2440A has six ROM/SRAM banks (including BANKO for boot ROM) and two ROM/SRAM/SDRAM banks.
The system manager on the S3C2440A can control access time, data bus width for each bank by S/W. The
access time of ROM/SRAM banks and SDRAM banks is controlled by BANKCONO~5 and BANKCONG6~7 control
register on the system manager. The data bus width for each ROM/SRAM banks is controlled by BWSCON control
register.

The ROM bankO is used for boot ROM bank, therefore data bus width of bankO is controlled by H/W. OM[1:0] is
used for this purpose.

The control of BWSCON, BANKCONO-7, REFRESH, BANKSIZE, and MRSRB6/7 is performed during the system
reset. A sample code for special register configuration is described below.

Sample code for special register configuration

;Set memory control registers
LDR r0,=SMRDATA
LDR r1,=BWSCON  ;BWSCON Address

ADD 2, r0, #52 :End address of SMRDATA
0

LDR r3, [r0], #4

STR 13, [rl], #4

CMP r2,r0

BNE 9%BO0

SMRDATA
DCD 0x22111120 :BWSCON
DCD 0x00000700 :GCSO0
DCD 0x00000700 :GCS1
DCD 0x00000700 :GCS2
DCD 0x00000700 :GCS3
DCD 0x00000700 :GCS4
DCD 0x00000700 :GCS5
DCD 0x00018005 ;GCS6 SDRAM(Trcd=3,SCAN=9)
DCD 0x00018005 ;GCS7 SDRAM(Trcd=3,SCAN=9)
DCD 0x008e0000+1113;Refresh(REFEN=1,TREFMD=0,Trp=2 clk,
; Trc=7 clk, Tchr=3 clk,Ref CNT)
DCD 0x32 ;Bank size, 128MB/128MB
DCD 0x30 ;MRSR 6(CL=3 clk)
DCD 0x30 ;MRSR 7(CL=3 clk)
4-8 ELECTRONICS
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ROM/SRAM BANK DESIGN

The ROM/SRAM banks 1-7 can have a variety of width of data bus, and the bus width is controlled by S/W. A
sample design for ROM/SRAM bank 1-7 is shown in Figure 4-6, Figure 4-7, Figure 4-8 and Figure 4-9.

EEPROM/
S3C2440X SRAM
ADDR[24:0] | A[21:0]
DATA[7:0] »| DQ[7:0]
DATA[7:0]
nGCS[7:1] » nCE
nOE » nOE
nWE » nWE
nWE
Figure 4-6. One-byte EEPROM/SRAM Bank Design

ELECTRONICS

Preliminary product information describes products that are in development,
for which full characterization data and associated errata are not yet available
Specifications and information herein are subject to change without notice.
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S3C2440X EEPROM/
SRAM
ADDR[24:1] * p A[21:0]
DATA[15:0 4 » DQ[7:0
[ ] DATA[7:0] Q7:0]
nGCS[7:1] . » nCE
nOE » nOE
NWBE[1:0] » nWE
NWBE[0]
EEPROM/
SRAM
- A[21:0]
p DQ[7:0]
DATA[15:8]
» nCE
» nOE
» nWE
nWBE[1]
Figure 4-7. Halfword EEPROM/SRAM Bank Design
S3C2440X SRAM
ADDR[24:1] | A[21:0]
DATA[15:0] p| DQ[15:0]
DATA[15:0]
nGCS[7:1] » nCE
nWE » nWE
nWE
nOE OF » nOE
NWBE[0] WnBEO » nLB
NWBE[1] nWBE[O] » nuB
nWBE[1]
Figure 4-8. Halfword SRAM Bank Design with Halfword SRAM
4-10 ELECTRONICS
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S3C2440X

ADDR[24:2] ®
DATA[31:0] *

DATA[7:0]

nGCS[7:1]
nOE 9
nWBE[3:0] ®

nWBE[0]

EEPROM/
SRAM

A[21:0]
DQ[7:0]

nCE
nOE
nWE

DATA[15:8]

NWBE[1]

EEPROM/
SRAM

A[21:0]
DQ[7:0]

nCE
nOE
nWE

DATA[23:16]

nWBE[2]

EEPROM/
SRAM

A[21:0]
DQ[7:0]

nCE
nOE
nWE

DATA[31:24]

nWBE[3]

EEPROM/
SRAM

A[21:0]
DQ[7:0]

nCE
nOE
nWE

Figure 4-9. Word EEPROM/SRAM Bank Design
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SDRAM BANK DESIGN FOR S3C2440A

Table 4-3. SDRAM Bank Address configuration

Bank Size Bus Width Base Component Memory Configuration Bank Address
2MByte x8 16Mbit (IM x 8 x 2Bank) x 1 A20

x16 (512K x 16x 2B) x 1

4MB x8 16Mb (2M x4 x2B) x2 A21
x16 (IMx8x2B) x2
x32 (512K x 16 x 2B) x 2

8MB x16 16Mb (2M x4 x 2B) x4 A22
x32 (1M x 8x 2B) x4
x8 64Mb (4Mx8x2B) x1
x8 (2Mx8x4B) x1 A[22:21]
x16 (2Mx16x2B) x1 A22
x16 (IMx16x4B) x1 A[22:21]
x32 (512K x 32 x4B) x 1

16MB x32 16Mb (2M x4 x2B) x8 A23
x8 64Mb (BMx4x2B) x2
x8 (AMx4x4B) x2 A[23:22]
x16 (4Mx8x2B) x2 A23
x16 (2M x 8 x4B) x2 A[23:22]
x32 (2Mx16x2B) x 2 A23
x32 (IMx16x4B) x2 A[23:22]
x8 128Mb (4Mx8x4B) x1
x16 (2Mx 16x4B) x1

32MB x16 64Mb (BM x4 x2B) x4 A24
x16 (4M x4 x 4B) x4 A[24:23]
x32 (4M x 8 x2B) x4 A24
x32 (2M x 8 x4B) x4 A[24:23]
x16 128Mb (4Mx8x4B) x2
x32 (2M x 16 x 4B) x 2
x8 256Mb (8BMx8x4B) x1
x16 (4Mx16x4B) x1

4-12 ELECTRONICS
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Table 4-3. SDRAM Bank Address configuration (Continued)

Bank Size Bus Width Base Component Memory Configuration Bank Address
64MB x32 128Mb (4Mx8x4B)x 4 A[25:24]
x16 256Mb (BM x8x4B) x2
x32 (4AMx 16 x4B) x 2
x8 512Mb (16M x 8 x4B) x 1
128MB x32 256Mbit (8M x 8 x 4Bank) x 4 A[26:25]
x8 512Mb (32M x4 x4B) x 2
x16 (16M x 8 x4B) x 2

The required SDRAM interface pin is CKE, SCLK, nSCS[1:0], nSCAS, nSRAS, DQM[3:0] and ADDR[12]/AP. The
sample design with SDRAM is shown in Figure 4-10 and Figure 4-11.

SYNC
S3IC2440% ORAM
ADDR[13:1]
ADDR[131] pe| A12:0]
BA » BA
DATA[1S0] et | DC[15:0]
DATA[15:0]
SCLK e LK
nRAS[0MSCS[0 w( NCE
HCASINSRAS [ nNSRAS
nCASZINSCAS | NSCAS
Ny E e NYE
MY BE[1:0)/ D@ M[1: 0] »| LODQMIIDQM
Dan[1:0]
Figure 4-10. Halfword SDRAM Design with Halfword Component
ELECTRONICS 4-13
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SYNC
S3C2440X DRAM
ADDR[14:2]
ADDR[14:2] > > A[12:0]
BA » BA
DATA[31:0] > »| DQ[15:0]
DATA[15:0]
SCLK » CLK
NRAS[0]/nSCSI0] » nCS
NCAS3/nSRAS » NSRAS
NCAS2/nSCAS »| NSCAS
nWE » nWE
NWBE[3:0//DQM[3:0] » LDQM/UDQM
DQM[1:0]
SYNC
DRAM
ADDR[14:2]
P A[12:0]
»| BA
p| DQ[15:0]
DATA[31:16]
» CLK
» nCS
»| NSRAS
»| NSCAS
» NWE
»| LDQM/UDQM
DQM[3:2]
Figure 4-11. Word SDRAM Design with Half-word Component
4-14 ELECTRONICS
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PC CARD (PCMCIA) INTERFACE APPLICATION USING CL-PD6710 (CIRRUS LOGIC)

The PC card (PCMCIA card) can be interfaced with S3C2440A using following components:

e CL-PD6710 from Cirrus logic

e TPS2211 from Texas Instruments

We tested the PC card interface by accessing the card information structure (CIS) in the modem card as

Figure 4-12, using following test code.

File Name File Descriptions
pd6710.h CL-PD6710 register definitions
pd6710.c CL-PD6710 PC Card program

Serial Port USB Port Configuration

Sl DMW vL49  [COMT115200bp=] [USE:x]

Help

=10] x|

Insert PC card???
Card is inserted.
3.3V card is detected.

[Card Information Structure
cisEnd=8"aé

28, 4, 7,c8, 8, 8,15,29, &,

31,2e,308,20,28, 8, 68,ff,21,
22,3, 2, ¢, £f,13, 5, 1, 3,

21,b5,1e,4d,14, 8,ff,

[FD6718 test for reading pc_card CIS]

PC card interrupt is occurred.
PC card interrupt is occurred.

PC card interrupt is occurred.

]

1, 4,df,ba, 1,FF,1c, &, 2,d9, 1,FF,18, 2,dF, 1,7/ e deeeeeeeua..

1,53,41,4d,53,55, %, /7 -ooenn .. SAMSUN

47,20,20,20,20,20,20, 0,53,43,46,43,2d,56 45,52,/ /6 _SCFC-UER

2, 4, 1,22, 2,1, 1,//1.8 ...
8, 2, £,1b, 8B,cB,chd, /" el

at, 1,55, 8, 8,28,1b, 6, @8, 1,21,b5,1e,4d,1b, a,//..U.. .... I | P
c1,41,99, 1,55,64,F0,FF,FF,208,1b, 6, 1, 1,21,b5,//.A..Ud... .... e
1e,4d,1b, f,c2,41,99, 1,55,ea,01,f8, 1, 7,F6, 3,//.H...A..U.a.....
1,ee,28,1b, 6, 2, 1,21,b5,1e,4d,1b, f,c3,M11,99,//.. .... t..H...A.
1,55%,ea,61,78, 1, /,76, 3, 1,ee,28,1b, 6, 3, 1,//.U.8p..v... ....

el

Figure 4-12. PC Card CIS Access Example on S3C2440A

ELECTRONICS
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10BASE-T ETHERNET CONTROLLER (CS8900A) INTERFACE
The 10BASE-T Ethernet can be supported on S3C2440A using following components:

e CS-8900A from Cirrus logic
¢ XFMRS XF10B11A-COMB1-2S is Ethernet RJ45 with transformer.

[IS AUDIO CODEC (UDA1341TS) CONNECTION WITH S3C2440A
The S3C2440A IIS interface example circuit is as follows:

¢« UDA1341TS from Philips Semiconductors.
e The L3 interface of Philips (L3MOD, L3CLOCK and L3DATA) is realized by general 1/0 port.

« Refer to the sample code of audio application which plays GPCM file.

UDA1341TS

12SSCLK —» BCK
I2ZSLRCK ——— (WS
12SSDO —— | DATAI DATAO ———» 12SSDI
CDCLK — | SYSCLK

GPB2 ——»{ L3BMODE
GPB4 ——®{ L3CLOCK
GPB3 ——»{ L3DATA

VINL1 ¢———— MICROPHONE
VINLZ [«¢————— IN

Speaker 4—— VOUTL
OUT «+——— VOUTR QMUTE 1

Figure 4-13. UDA1341TS Connection with S3C2440A

AC97 AUDIO CODEC (STAC9767) CONNECTION WITH S3C2440A
The S3C2440A AC97 interface example circuit is as follows:

» STAC9767 from SIGMATEL.

e The AC97 interface (AC_SYNC, AC_BIT_CLK, AC_ nRESET, AC_SDATA_IN and AC_SDATA_OUT) is
realized between S3C2440A and STAC9767.

« Refer to the sample code of audio application which plays GPCM file.

4-16 ELECTRONICS
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STAC9767
X97SDO  ——»| SDATA_OUT HP OUT L }——»
HEADPHONE
X97SDI <+——{SDATA_IN HP_OUT Rl—»
X97BITCLK 4+——BIT_CLK LINE_IN L |¢——
X97SYNC ——p{SYNC LINE_IN Rje——— UINEIN
X97RESETn —pf RESET# MIC1|¢——— MICROPHONE

Figure 4-14. STAC9767 Connection with S3C2440A

LCD CONNECTION WITH S3C2440A

The S3C2440A LCD interface example circuit is as follows:

UG-32F04 (320x240 mono STN LCD) from SAMSUNG DISPLAY DEVICES CO., LTD. (refer to Figure 4-14)
— TL497CAN can be used to make VEE (-25V).

UG-24U03A (320x240 mono STN LCD) from SAMSUNG DISPLAY DEVICES CO., LTD. (refer to Figure 4-15)
— VEE is generated by the circuit on LCD module.

— VL is 2.4V typically.

— DISPON  H: display on, L: display off

— nNnEL_ON H:ELoff L:ELon

KHS038AA1AA-G24 (256 color STN LCD) from KYOCERA Co. (refer to Figure 4-16)
— DISP signal can be made using I/O port, or power control circuit or NRESET circuit.

— V1-V5 can be made using the power circuit recommended by the LCD specification.

LTS350Q1-PEL1 (256K color TFT LCD) from SAMSUNG ELECTRONICS CO., LTD. (refer to Figure 4-17)
— VDD_LCDI is typically 3.3V.

LP104V2-W (262,144 color TFT LCD, 10.4") from LG Philips (refer to Figure 4-18)
— VDD_LCDl is typically 3.3V.

V16C6448AB (640x480 TFT LCD) from PRIMEVIEW (refer to Figure 4-19)
— VDD_LCDI, VD and control signal are typically 5.V.

ELECTRONICS 4-17
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FG
1 NC I
FLM
CL1
CL2
VSS
DO
D1
D2
D3
VSS

(from S3C2440X) VEE VDD vbD
VO 15

R J VEE xgg > 14
10K ——— —4 15

0000

VFRAME
VLINE
VCLK

YyvyYyy

CO~NOOUDMWNE

VDO
VD1
vD2
VD3

YyvYyYVvVvYy

0000

10
11
12

|

000

= =2 UG-32-F04-WCBNO-A

Figure 4-15. UG-32F04 Connection with S3C2440A (320x240 Mono STN LCD)

VSS1 1
VERAME FPERAME , 1
VLINE FPLINE 1 3
VSS2 " d 2
FPSHIFT _ |
VCLK VSS3 i S Z
PORT(DISPON) DOFF »q 7
DRDY __ _
VM »d 8
VCC J
3.3V 9
VSS4 d 10
VEE *q 11
VL .
DO .
VDO D1 > 913
VD1 = > d 14
VD2 D3 » Jd 15
VD3 » g 16
VSS5 d 17
3.3V X2 d 18
o Y1 wvd 19
é; x—d 20
xd 21
L VSS6 d 22
EL-VCC d 53
PORT(nEL-ON) EL-ON d 24
(from S3C2440X) = UG24U03A

Figure 4-16. UG24U03A Connection with S3C2440A (320x240 Mono STN LCD)
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VFRAME
VLINE
VCLK
VM
VD7
VD6
VD5
VD4
VD3
VD2
VD1
VDO

(from S3C2440X)

FLM_,
LOAD _ >
<

—» DISPOFF DISP o of 4

— VDD VDD , 4 5
vbb ] ¢

— vss | 5

> = WM DF__, d s

_ ~ Vo VO 4 9

> V1 Vi, d 10

—> V2 V2 :o 11

—> V4 V4 > O 13
V5~ J 14

= VD7 D7 ;2 15
- VD6 D6, 16
VD5 DS, 417
VD4 D4 18
VD3 D3 419
VD2 D2, 4 20
VD1 DI ,421
VDO DO, 422

KHS038AA1AA-G24-95-14

Figure 4-17. KHS038AA1AA-G24 Connection with S3C2440A (256 Color STN LCD)

ELECTRONICS

Preliminary product information describes products that are in development,
for which full characterization data and associated errata are not yet available
Specifications and information herein are subject to change without notice.

4-19




SYSTEM DESIGN

2004.03.27

S3C2440A

VOFF O—p—|
><——
<——

VON O——p—|

VCOM
=) LAVDD O 1
LDVDD O 1
_L_
LVFRAME -
LVLINE REY
LLEND
LD18
LD19
LD20
LD21
LD22
(from S3C2440X) LD23
LD10
LD11
LD12
LD13
LD14
LD15
LVCLK Y
VREFO
VREF1
VREF2
VREF3
VREF4
— VREE5 |
_ VREF6 |
LVM -
LD2 -
LD3 _—
LD4 _
LD5 _—
LD6 _
LD7 —
<
<

CONOUIDWNR

FH12_50P

Figure 4-18. LTS350Q1-PE1 Connection with S3C2440A (Samsung 3.5” Transflective TFT LCD)
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(from S3C2440X)

VCLK
VLINE
VFRAME

vD18
VD19
VD20
vD21
vD22
vD23

VD10
VD11
vD12
vD13
vD14
VD15

VD2
VD3
vD4
VD5
VD6
VD7

VM
PVDD_LCDI
PVDD_LCDI

000000

000000

000000

O©CO~NOOUAWNEPE

DF9B-31S-1V

Figure 4-19. LP104V2-W Connection with S3C2440A (LG Philips 10.4” TFT LCD)
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ok dJ 1
VCLK - » g 2
HSYNC VSV”C » o 3
VSYNC Sync > d 4

GND

q 5

RO

= Jd 6
VD11 > 7
VD12 Eg » d 8
VD13 » d 9
VD14 R4 » d 10
VD15 RS > d 11

GND

o0 q 12
VD5 o1 » d 13
VD6 = » d 14
VD7 » d 15
vD8 G3 » d 16
VD9 G4 > d 17
VD10 GS » d 18

GND d 19

BO d 20
VDO Bl » d 21
VD1 Sg » d 22
VD2 o2 » d 23
VD3 » d 24
VD4 BS » g 25

GND

DENB q 26
VDEN Voo > g 27
VDD_LCDI(5V) g 28

VCC

d 29

R/L d 30

u/D d 31
(from S3C2440X) = V16C6448AB

Figure 4-20. V16C6448AB Connection with S3C2440A (TFT LCD)
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SYSTEM DESIGN WITH DEBUGGER SUPPORT

MULTI-ICE

The S3C2440A has an Embedded ICE logic that provides debug solution from ARM. MULTI-ICE enables you to
debug software running on the S3C2440A. Embedded ICE logic is accessed through the Test Access Port (TAP)
controller on the S3C2440A using the JTAG interface.

JTAG port for Embedded ICE Interface

When you build a system with the S3C2440A Embedded ICE interface, you should design a JTAG port for MULTI-
ICE interface. Usually, the interface connector is a 20-way box header, and this plug is connected to the
Embedded ICE logic interface module using 20-way IDC socket.

The JTAG port signals, nTRST, TDI, TMS and TCK have to be connected to pulled-up register (10K ohm)
externally.

The pin configuration and a sample design are described in Figure 4-21 and Figure 4-22, respectively.

@®E @
OEEOOHOLO OB W
1
Pin Name Function
1 VTref System Power
2 Vsupply System Power
3 NnTRST Test reset, active low (connected pull-up reg.)
5 TDI Test data in (connected pull-up reg.)
7 TMS Test mode select (connected pull-up reg.)
9 TCK Test clock (connected pull-up reg.)
11 RTCK Return test clock (connected pull-down reg.)
13 TDO Test data out
15 NSRST Connected to nRESET and nTRST through 470 ohm resister
17 DBGRQ NC
19 DBGACK NC
4,6, 8, 10, 12, 14, 16, 18,20 | GND System Ground

Figure 4-21. MULTI-ICE Interface of JTAG Connector
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VDD
2\
J S3C2440X
10K %1OK 10K 10K
r——————= 1
| C) <:) |
| |
| |
| |
| |
I I
—©® &— oI
| |
| |
—B) O)— T™S
| |
| |
0—:—@ 11 :
| |
I |
|
|
L
4 @ : NN\ _ TDO
I 470 ohm or Switch
p I ‘ @ % Multi-ICE use : Off
I : § 330 ohm | Multi-ICE not use : On
|
20 @—1—x
L __ I
NnRESET | NRESET
(from Reset logic) |
A4
GND
Figure 4-22. MULTI-ICE Interface Design Example
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CHECK ITEMS FOR SYSTEM DESIGN WITH S3C2440A

When you design a system with the S3C2440A, you should check a number of items to build a good system. The
check items are described below.

» The OM[3:0] pin has to be configured.

e If EXTCLK pin is used for MPLL and UPLL, XTIpll has to be connected to VDD. If XTlIpll pin is used for MPLL
and UPLL, EXTCLK has to be connected to VDD.

e If aninput pin is unused, connect the pin to VDD or GND. If the pin is floated, S3C2440A may not operate.

ELECTRONICS 4-25
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NOTES
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REVISION HISTORY

1. Revision 0.1(2003/11/28)

- Preliminary version for SMDK2440 Ver 0.18
By Y. H. Lee

Item Page No. Remark

AC97 1-1 Following words are added
- AC97 interface

1-2 AC97 Block is added into “Figure 1-1. SMDK2440 Function Block

Diagram”.

1-3 Following item is added into “FEATURES".
- AC97 interface (sound CODEC audio input/output)

1-5 AC97 Block is added into “Figure 1-3. Detailed SMDK2440 Board

Diagram”.

1-19 New contents on IIS & AC97 Interface Configuration are added
into SMDK 2440 App Notes.

4-16 New contents and Figure 4-14 on AC97 Connection with
4-17 S3C2440X are added into App Notes.

Camera 1-18 Camera connector pin assignment has been changed in the
“CAMERA Interface Connector on SMDK2440".

Programming
3-51 Changed as follows:

Intel Strata

- Before
Flash with

J1: 2-3 (short) J2:1-2 (short) J3:1-2 (short) J4: 2-3 (short)
OPENICE32 Af

- After

J1-B: 2-3 (short) J2-B: 1-2 (short) J3-B: 1-2 (short)
J4-B: 2-3 (short)

Preliminary product information describes products that are in development,
for which full characterization data and associated errata are not yet available
Specifications and information herein are subject to change without notice.
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2. Revision 0.11(2004/01/16)
- Preliminary version for SMDK?2440 Ver 0.18

By Y. H. Lee
Item Page No. Remark
Overview 1-1 The CPU Board and Base Board revision number for S3C2440A
is added.
CPU Board Version Rev 0.18
Base Board Version Rev 0.18
Microprocessor 1-2 The MCU name is changed from S3C2440X to S3C2440A.
Name
1-4 In the Figure 1-2, The MCU name is changed from S3C2440X to
S3C2440A.
1-5 In the Figure 1-3, The MCU name is changed from S3C2440X to
S3C2440A.
2.1 In the Figure 2-1, The MCU name is changed from S3C2440X to
S3C2440A.
s &  AC97 1-19 Changed as follows:
Interface . .
register => resistor
SMDK  Power 1-4 New Step-Down Voltage Controller Block (U13-C) is added to
Plane SMDK Power Plane.
SMDK2440 1-6 Changed as follows:
System
J35-C =>J3-C
Configurations
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